GemStar®

Infusion Pump

System Operating Manual

For use with the
Hospira GemStar® Pain Management Pump
List 13088-04-01/02
Hospira GemStar® Infusion Pump
System Operating Manual

For use with the
Hospira GemStar® Pain Management Pump

List 13088-04-01/02

PLEASE
Read this entire manual before
using the Hospira GemStar® Pump

This manual is designed for use by healthcare professionals, caregivers, and patients. The Hospira Technical Support Operations hotline is available 24 hours a day (in the USA) to provide consultation and technical assistance regarding the Hospira GemStar® Pump.

In the USA: Hospira Technical Support Operations
1-800-241-4002

Outside the USA: Contact your local Hospira sales office

To order additional copies of this manual
(List 13088) call Hospira Customer Care:
1-877-9HOSPIRA
(1-877-946-7747)
# Change History

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description of Change</th>
<th>Pages Changed</th>
</tr>
</thead>
<tbody>
<tr>
<td>430-10984-001</td>
<td>Original Issue</td>
<td>N/A</td>
</tr>
</tbody>
</table>

(Rev. 03/06)
## Contents

1. Introduction  
   - GemStar® Pump Layout .......................... 2  
   - GemStar® Pump Components ..................... 4  
   - GemStar® Pump Features ......................... 5  
   - Menu System .................................... 6  
   - Operating Modes .................................. 8  
   - Indications for Use .............................. 9  
   - Contraindications for Use ..................... 10  
   - Warnings and Cautions ......................... 10

2. Basic Operation  
   - Overview ...................................... 17  
   - Selecting a Power Source ....................... 18  
   - Using the GemStar® Docking Station ......... 24  
   - Powering On the Pump ......................... 25  
   - Accessing the Delivery Mode Menu ........... 27  
   - Programming the Pump .......................... 28  
   - Starting a New Container ..................... 30  
   - GemStar® Pump Set ............................. 30  
   - Loading the Cassette .......................... 33  
   - Releasing the Cassette ......................... 34  
   - Priming a GemStar® Pump Set ................. 35

3. Pain Management  
   - Therapy Features and Specifications .......... 45  
   - Pain Management Programming ................ 47  
   - Bolus Delivery .................................. 48  
   - Rate Titration .................................. 49  
   - Loading Dose Delivery .......................... 50  
   - Changing a Pain Management Program ........ 51  
   - Pain Management Programming Worksheet .... 52

4. Options Menu  
   - Overview ...................................... 55  
   - Tips for Using the Options Menu .............. 55
## Contents

- Review Program .......................................................... 57
- Histories ................................................................. 57
- Keypad Lock .............................................................. 62
- Change Pump Settings .................................................. 64
- Set Clock ................................................................. 66
- Print ............................................................................. 67
- Speed Protocol ............................................................ 68
- Connecting to the Data Port .......................................... 70
- Transferring Data Using a Computer .............................. 75

### 5. Clinician Instructions

- Clinician Locking Sequence Instructions ....................... 78
- Program and Deliver a Clinician Activated Loading Dose . 79
- Shift Totals and History .............................................. 79

### 6. Troubleshooting

- Alarm Messages .......................................................... 82
- Alert Messages ........................................................... 91
- Other Display Messages .............................................. 94

### 7. Maintenance

- Pump Storage ............................................................ 95
- Cleaning and Disinfecting .......................................... 95
- Repair ....................................................................... 97

### 8. Operation Test

- Equipment Required .................................................. 99
- Test Setup ............................................................... 100
- Performing the Operation Test .................................... 100
- Printing Test Results ................................................ 105
- Operation Test Checklist ........................................... 107

### 9. Optional System Components

- Connecting the Bolus Cord ......................................... 112
- Using the GemStar® Lockboxes .................................. 112
- Using the Hospira Carrying Cases ............................... 115
- Using the GemStar® Docking Station ......................... 121
Contents

10. Pump Sets ................................................................. 123

11. GemStar® Pump Specifications ........................................ 127
   Occlusion Information .................................................. 130

12. Warranty/Technical Assistance ........................................ 145

A. Electrical Potentials ..................................................... 147
   Guidance on EMC Compatibility ....................................... 147
   Information Regarding Electrostatic Discharge (ESD) .............. 148

Index ............................................................................. 149

IEC Symbols .................................................................... inside back cover
Chapter 1

Introduction

The Hospira GemStar® Pain Management Pump is a small and lightweight, single-channel infusion device designed for use in the home, in the hospital, or anywhere electronic infusion is required. The GemStar® Pump can be powered by AC mains adaptor, rechargeable battery pack, docking station, or two disposable AA alkaline batteries. When powered by batteries, the GemStar® Pump is ideal for ambulatory patients.

The following conventions are used throughout this manual:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Use</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL CAPS</td>
<td>Display messages</td>
<td>The pump displays: ENTER TO CONFIRM.</td>
</tr>
</tbody>
</table>

WARNING: A WARNING message contains special safety information and must be observed at all times. Failure to observe a warning message could be life threatening.

CAUTION: A CAUTION contains information that could prevent irreversible product damage or hardware failure. Failure to observe a caution could result in serious patient or user injury.

Note: A NOTE contains information or examples to help explain instructions.

Tip: A TIP contains information that makes the pump easier to use.

Note: Examples are provided only to help explain a pump function and may not be clinically relevant. Graphics are for illustrative purposes only and may not reflect the actual product.
1. Introduction

GemStar® Pump Layout

Shown approximate size
1. Introduction

1. DISPLAY • Displays the pump’s status.
   • Silences an alarm.
   • This silences an alert for five minutes and an alarm for two minutes.
2. • Stops infusion.
3. • Starts infusion.
4. • Lights continuously when the pump is powered by AC mains.
   • Flashes when the pump is powered by external batteries (e.g., battery pack).
   • Not lit when using disposable AA batteries.
5. • Powers the pump on or off. To power-off the pump, press and hold until the display clears.
6. • Returns to previous steps during programming.
   • Exits Help, Change, and Options menus.
8. • Displays the following menu items from the STOP or RUN mode*: New Container Change Program New Program • Resets a numeric value to zero.
9. • Displays the following Options Menu items from the STOP or RUN mode*: 1 Review Program 4 Pump Settings 7 Speed Protocol 2 Histories 5 Set Clock 3 Keypad Lock 6 Print • Scrolls through program review and help messages.
   • Toggles between AM and PM in time-based entries.
   • DOWN arrow toggles between units of measure when entering concentrations.
10. • Toggles between AM and PM in time-based entries.
   • UP arrow enters a decimal point in numeric entries.
   • Scrolls back by one screen in program review.
11. • Responds “YES” to display questions.
   • Accepts entries and goes to the next step.
12. • Responds “NO” to display questions.
13. • Displays information during programming steps and alarm conditions.
   • Displays Shift Totals, except during programming steps and alarm conditions.
14. • Clears an AIR-IN-LINE alarm.
   • Primes a GemStar® Pump Set.
15. [0] - [9] • Selects menu items and enters numeric values. If two numbers appear before a menu item (e.g., 02), press both number keys to select that item.

* Not all menu items are available with all modes.
1. Introduction

GemStar® Pump Components

1. Bolus Button
   Press this button to start a bolus delivery if available in the current program.

2. Pole Clamp Track
   Use to connect to an optional pole clamp.

3. Cassette Release Button
   Push down on this button to release the cassette.

4. Power Connector
   Use to connect the AC mains adaptor.

5. Data Port Connector
   Use to connect the GemStar® serial cable.

6. Bolus Connector
   Use to connect a bolus cord.

7. Tubing Channel
   Place the pump set tubing in this channel.

8. Cassette Pocket
   Load the cassette into this pocket.

9. I.V. Tubing Guide
   Use to hold the I.V. tubing.

10. Battery Pack Connector
    Use to connect the GemStar® Rechargeable Battery Pack.

11. Battery Compartment
    Install two fresh, disposable AA batteries in this compartment.
1. Introduction

## GemStar® Pump Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Reference Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adjustable Settings</strong></td>
<td>Adjusts the distal occlusion pressure limits, air sensor sensitivity, real-time clock, and audible alarm volume.</td>
<td>Chapter 4 Options Menu</td>
</tr>
<tr>
<td><strong>Alerts and Alarms</strong></td>
<td>Signals audible and visual alarms when attention is required.</td>
<td>Chapter 6 Troubleshooting</td>
</tr>
<tr>
<td><strong>Audible Keypad Response</strong></td>
<td>Sounds a single beep when any key is pressed. If an invalid key is pressed, the pump sounds a flutter tone.</td>
<td>Chapter 1 Introduction, <em>GemStar® Pump Layout</em></td>
</tr>
<tr>
<td><strong>Keypad Lock</strong></td>
<td>Restricts access to various options. Four lock levels are available.</td>
<td>Chapter 4 Options Menu and Chapter 5 Clinician Instructions</td>
</tr>
<tr>
<td><strong>New Container</strong></td>
<td>Repeats the current program without reprogramming the pump.</td>
<td>Chapter 2 Basic Operation</td>
</tr>
<tr>
<td><strong>Power-on Self-test</strong></td>
<td>Performs a self-test each time the pump is powered on.</td>
<td>Chapter 2 Basic Operation</td>
</tr>
<tr>
<td><strong>Operation Test</strong></td>
<td>Performs user-assisted tests to verify the pump is operating properly.</td>
<td>Chapter 8 Operation Test</td>
</tr>
<tr>
<td><strong>Program History</strong></td>
<td>Maintains a history event log, with a date and time stamp of each event for each program. Review the history on the display, or download it to a printer or computer.</td>
<td>Chapter 4 Options Menu</td>
</tr>
<tr>
<td><strong>Speed Protocols</strong></td>
<td>Stores up to nine frequently used programs in the pump’s memory for quick access.</td>
<td>Chapter 4 Options Menu</td>
</tr>
</tbody>
</table>
1. Introduction

Menu System

The GemStar® Pump uses a menu system that provides step-by-step instructions through all of the pump’s functions. Refer to the following table for a list of functions in each menu.

Use the keypad to select menu items, respond to display messages, and enter numeric values. For example, press [2] to select HISTORIES from the Options Menu.

*Note: Menu items may vary depending on the pump’s configuration.*

Tip: A menu item does not have to be on the display to be selected. For example, when the Options Menu first displays, only the first four menu items are shown. Instead of pressing the down arrow to see the other menu items, press [5] to go directly to SET CLOCK.
1. Introduction

<table>
<thead>
<tr>
<th>To display this menu:</th>
<th>Do this:</th>
<th>Menu Items Available</th>
</tr>
</thead>
</table>
| Delivery Mode Menu          | 1 Press CHANGE to display the Change menu. 2 Select NEW PROGRAM. | 1 CONTINUOUS  
                                |                                                                                  | 2 BOLUS  
                                |                                                                                  | 3 CONT + BOLUS |
| Change Menu                 | Press CHANGE.                                | 1 NEW CONTAINER  
                                |                                                                                  | 2 NEW PROGRAM  
                                |                                                                                  | 3 CHANGE PROGRAM |
|                             | Note: If the current therapy is Weight Dosed or mL/hr Only and the pump is in RUN mode: 3 TITRATE VTBI will replace 3 CHANGE PROGRAM on the menu display. |                                                                     |
|                             | Note: Piggybacking is available only in mL/hr Only and Continuous therapies. Note: Menu items change depending on when Change Menu is viewed. |                                                                                   |
| Options Menu                | Press OPTIONS.                               | 1 REVIEW PROGRAM  
                                |                                                                                  | 2 HISTORIES  
                                |                                                                                  | 3 KEYPAD LOCK  
                                |                                                                                  | 4 PUMP SETTINGS  
                                |                                                                                  | 5 SET CLOCK  
                                |                                                                                  | 6 PRINT  
                                |                                                                                  | 7 SPEED PROTOCOL |

For more information on: Refer to the following pages:

Delivery Mode Menu Chapter 3 Pain Management, page 45.

Change Menu For menu item [1], refer to Starting a New Container in Chapter 2 Basic Operation, on page 30. For menu items [2] and [3], refer to Chapter 3 Pain Management, page 45.

Options Menu Chapter 4 Options Menu, page 55.
1. Introduction

Operating Modes

The GemStar® Pump has four operating modes:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Mode</td>
<td>The pump enters the HELP mode when HELP is pressed during programming or an alarm condition. The HELP mode displays additional information about the current condition.</td>
</tr>
<tr>
<td>Programming Mode</td>
<td>The pump enters the PROGRAMMING mode after the pump is powered on or when Fig is pressed.</td>
</tr>
<tr>
<td>Run Mode</td>
<td>After Fig is pressed, the pump enters the RUN mode, even when not infusing.</td>
</tr>
<tr>
<td>Stop Mode</td>
<td>When programming is complete, the pump enters the STOP mode until Fig is pressed.</td>
</tr>
<tr>
<td></td>
<td>When the programmed therapy is complete, and during certain alarm conditions, the pump automatically enters the STOP mode.</td>
</tr>
<tr>
<td></td>
<td>Press STOP to enter the STOP mode at any time, except during a CHECK CASSETTE alarm.</td>
</tr>
</tbody>
</table>
1. Introduction

Indications for Use

Physicians or certified, licensed healthcare professionals should always oversee infusions. Healthcare professionals should always supervise pump users and instruct users in pump operation and troubleshooting. Instruction should include how to prevent intravenous (I.V.) related complications, including how to prevent accidental infusion of air.

The pump is suitable for intravenous, arterial, subcutaneous, short-term epidural infusion of general I.V. fluids and medications. The epidural route is recommended to provide anesthesia or administer analgesia for periods up to 96 hours.

Note: Epidural administration of anesthetics is recommended in the continuous mode only. Epidural administration of analgesics may be delivered by continuous, bolus, or continuous with bolus.

For epidural use, the administration of drugs is restricted to those anesthetic and analgesic drugs approved for continuous epidural administration: e.g., Chloroprocaine Hydrochloride USP, Lidocaine Hydrochloride USP, and Morphine Sulfate Injection USP (Preservative Free).

WARNING: Delayed respiratory depression following continuous epidural administration of preservative-free morphine sulfate has been reported.

For epidural administration, the following is recommended:

- Nylon or Teflon® catheter
- Pump sets without Y-sites
- Stickers for the tubing indicating ongoing administration

Note: Facilities practicing epidural anesthesia/analgesia must be staffed and equipped to manage cardio-pulmonary resuscitation (CPR). Supplies should include oxygen, naloxone, and other appropriate resuscitative drugs and equipment. Monitor patients continuously (e.g., oximetry) during epidural administration. Frequently observe patient for side effects (for up to 24 hours) following completion of drug administration by the epidural route.
1. Introduction

Contraindications for Use

Persons who do not have the mental and physical capability or the emotional stability to properly use the GemStar® Pump should not operate this pump.

DO NOT use the following with the GemStar® Pump System:
- Drugs not compatible with silicone rubber or PVC plastic
- Drugs not stable under infusion conditions

Warnings and Cautions

Pay attention to the following warnings and cautions when operating the GemStar® Pump. These warnings and cautions are repeated in the manual when relevant to the procedure being discussed. Pay attention to all alert messages.

General Warnings and Cautions
- Federal (USA) law restricts this device to sale by or on the order of a physician or other licensed practitioner.
- Manual references to specific values are approximate only, unless indicated otherwise. Air-in-line sensitivity values are approximate only.
- When a proximal occlusion alarm activates, DO NOT power-off the pump.
- Closely supervise patients who are likely to be adversely affected by unintended operations and failures, including interrupted medication or fluid infusion. Ensure provisions for immediate corrective action are available.

Regarding Drugs Used, Pump Sets, and Containers
- USE ONLY GemStar® Pump Sets with the GemStar® Pump. Use of unauthorized sets may result in injury to the patient or damage to the pump.
- Some microbore tubing delivery accuracy may be affected when used at extreme operating temperatures (<10°C, >35°C), relative humidity (<20%) and delivery rates (<4.9 mL/hr, >350 mL/hr). Refer to individual set labels for specific instructions and operating conditions.
- Delivery accuracy may be impacted when there is air present in the cassette. Follow the instructions in the individual set labels to remove any visible air from the cassette.
- Ensure slide clamp or lower CAIR® clamp is open prior to inserting cassette.
- When using pre-filled vials, ensure vial and injector are securely locked in lockbox before beginning delivery.
1. Introduction

- A cracked vial might not show evidence of leakage until delivery pressure is applied.
- When using nonvented syringes, the system may underdeliver. System delivery accuracy could be reduced by as much as 5%.
- When using PCA vials (except in a lockbox with a spring assist mechanism), the system may underdeliver. System delivery accuracy could be reduced by as much as 5%.
- Variations in filling head (such as container height) may affect delivery accuracy by no more than 5%.
- When using the GemStar® Spring Assist Mechanism (SAM) Lockbox, USE ONLY GemStar® Pump sets designated for use with the GemStar® SAM Lockbox. Failure to use designated sets could result in unrestricted flow.
- NEVER use drugs that are incompatible with silicone rubber or PVC plastic (unless these items are specially treated and labeled to be compatible with such drugs).
- To reduce the loss of potency for drugs known to be absorbed by PVC plastic and silicone, begin infusion as soon as practical after priming the pump set. Use of high flow rates during infusion will minimize drug absorption.
- DO NOT use medications that are unstable under infusion conditions.
- ALWAYS use connections with Luer Lock™ fittings.
- To prevent contamination, use aseptic technique with all fluid-path connections. Remove the protective coverings as assembly progresses.
- ALWAYS place the flow stop in the closed position when the set is not in the pump.
- Before installing the cassette in the pump, ensure all slide or lower CAIR® (roller) clamps are open. Failure to open the slide or lower CAIR® (roller) clamps BEFORE installing the cassette may result in restricted flow.
- DO NOT back-prime the pump set using a syringe. Back priming may result in restricted flow.
- Ensure the cassette is properly installed. When properly installed, all four cassette latches are visibly holding the cassette securely in the cassette pocket.
- Ensure the tubing is behind the tubing guide (at the distal end).
- Arrange tubing, cords, and cables to minimize the risk of patient strangulation or entanglement.
- NEVER use vented fluid containers (e.g., glass or rigid plastic) unless suspended
1. Introduction

from a pole.

- Stop infusion if signs or symptoms of infiltration occur.
- GemStar® Pump Sets contain a pressure-activated anti-siphon valve to reduce the potential for gravity flow at a typical 36-inch head height.
- Failure to use the pressure-activated anti-siphon valve may result in unrestricted flow if the cassette is not properly installed in the pump.
- Always close the slide clamps before removing the cassette from the pump.

Regarding Air-In-Line and Infusion

- To reduce the risk of infusing air, use an air-eliminating filter when the air sensitivity is set to OFF.
- ALWAYS prime the pump set to remove all air from the cassette, tubing, and injection site prior to connecting to the patient.
- ALWAYS disconnect the pump set from the patient prior to priming or purging.

Regarding Pump Operation

- If the pump does not perform as stated in this manual, remove the pump from service IMMEDIATELY.
- If the pump does not display the self-test or if beeps do not sound at power-on, check all power connections and install two fresh, disposable AA batteries. If the problem continues, contact Hospira Technical Support Operations before using the pump.
- Ensure a cassette is installed in the pump before connecting to a printer or computer. **If the pump is connected to a patient:** BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a printer or computer.
- Disconnect the pump from the patient BEFORE performing the Operation Test.
- ALWAYS connect to a grounded AC mains power source when using AC mains power. If the quality of the grounding source is in doubt, operate the pump only with batteries.
- **USE ONLY** the AC mains adaptors specifically labeled for use with the GemStar® Pump.
- **USE ONLY** the AC mains adaptor specifically labeled for use with the GemStar® Pump to charge the battery pack.
1. Introduction

- The Hospira GemStar® AC Mains Adaptor is for use with the GemStar® Pump or GemStar® Rechargeable Battery Pack only. DO NOT use the GemStar® AC mains adaptor with other products.
- During charging, the battery pack is warm. If the battery pack becomes hot to the touch, IMMEDIATELY unplug the AC mains adaptor and contact Hospira Technical Support Operations.
- Use only the Li-Ion Docking Station and Li-Ion Battery Pack with the GemStar® Pump.
- With the Li-Ion Battery Pack, the LED indicator flashes yellow/green when an error condition has occurred or when the temperature is too high to charge the battery pack. In temperatures above 95°F (35°C), cycle AC power to confirm if battery is charged or if error condition exists. If LED flashes green/yellow, do not rely on external battery. Move device to cooler temperature and recharge prior to use. Refer to the battery pack insert for important information and precautions regarding activating and charging the Li-Ion Battery Pack.
- When removing the cord (from the docking station, bottom of the battery pack, or bottom of the pump), firmly grasp the connector and pull straight out. DO NOT twist or bend the cord or connector.
- To ensure proper pump operation, ALWAYS replace BOTH disposable batteries with fresh, disposable AA batteries when a change is required.
- ALWAYS fully close the battery door when using disposable batteries.
- DO NOT use rechargeable batteries in the battery compartment.
- Ensure two fresh, disposable AA batteries are installed for backup power when using other external power sources (e.g., AC Mains adaptor, docking station, battery pack). The pump will continue to operate on backup power if the external power source fails. In the event that the internal batteries are removed while the pump is operating, the power loss event may not be logged in the history, the programmed therapy may not be retained, and the alarms (audible and visual) may not occur.
- ALWAYS avoid sources of high-intensity electromagnetic radiation (e.g., radio transmitters, MRI scanners, microwave ovens, X-ray machines, and CAT scanners).
- Use of radio-frequency emitting devices, such as cellular telephones, 2-way radios, and Electrical Surgical Devices (ESU), in close proximity to this device may affect its operation.
- Possible explosion hazard exists if the pump is used in the presence of flammable anesthetics. NEVER use the pump in the presence of flammable or explosive...
1. Introduction

vapors.

- Non-hazardous, low-level electrical potentials are commonly observed when fluids are administered using infusion devices. These potentials are well within accepted safety standards, but may create artifacts on voltage-sensing equipment, such as ECG, EMG, and EEG machines. These artifacts vary at a rate that is associated with the infusion rate. If the monitoring machine is not operating correctly or has loose or defective connections to its sensing electrodes, these artifacts may be accentuated so as to simulate actual physiological signals. To determine if the abnormality in the monitoring equipment is caused by the infusion device instead of some other source in the environment, set the infusion device so that it is temporarily not delivering fluid (if clinically acceptable). Disappearance of the abnormality indicates that it was probably caused by electronic noise generated by the infusion device. Proper setup and maintenance of the monitoring equipment should eliminate the artifact. Refer to the appropriate monitoring system documentation for setup and maintenance instructions.

- The GemStar® Pump has been tested and found to comply with EMC/EMI limits in accordance with:
  - IEC/EN 60601-1-2 (2001) when using two AA disposable batteries or when connected to the GemStar® AC Adaptor
  - IEC/EN 60601-1-2 (2001) (ESD exemption) when using Li-Ion Docking Station or Li-Ion Battery Pack

When connected to other power sources or optional system components in commercial distribution before November 30, 2004, the GemStar® system complies with EMC/EMI limits in accordance with IEC/EN 60601-1-2 (1993). These limits are designed to provide reasonable protection against harmful interference in a typical medical installation. The equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to other devices in the vicinity. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference with other devices, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving device
- Increase the separation between the equipment
- Connect the equipment to an outlet on a circuit different from that to which the other device is connected
- Consult the manufacturer or field service technician for help
1. Introduction

- The use of portable and mobile RF equipment may have an impact on this and other pieces of medical equipment.
- Prior to using the GemStar® Pump and optional system components, refer to Appendix A for additional information and precautionary procedures regarding electrical potentials (electromagnetic compatibility and electrostatic discharge).

**Regarding Handling and Maintenance**

- Use proper care during unpacking, installation, and operation of the pump. If the pump is inadvertently mishandled, check connections and programmed data to ensure there is no damage. Refer to Chapter 8 Operation Test for further information.
- Accessory equipment connected to the analog and digital interfaces must be certified according to the respective IEC standards, (e.g., IEC 60950 for data processing equipment, and ICE 60601-1 for medical equipment). Furthermore, all configurations shall comply with the system standard IEC 60601-1-1. Any person who connects additional equipment to the signal input or output part configures a medical system, and is therefore responsible for ensuring that the system complies with the requirements of IEC 60601-1-1. If in doubt, contact Hospira Technical Support Operations.
- ALWAYS avoid dropping or hitting the pump. If the pump is dropped or hit, ALWAYS check connections and programmed data.
- NEVER use sharp objects (e.g., fingernails, pens, pencils, or other probes) to program or clean the pump.
- Use care not to damage the silicone seals around the sensor bodies in the cassette pocket.
- To avoid mechanical or electronic damage, NEVER submerge pump in water or other fluids and avoid fluid spills. If the pump becomes wet, dry it immediately with a dry, lint-free cloth. Check connections and programmed data.
- DO NOT touch connector ports. Connector ports may be susceptible to Electrostatic Discharge (ESD) damage.
- Some cleaning and sanitizing compounds may slowly degrade components made from some plastic materials. DO NOT use compounds containing combinations of isopropyl alcohol and dimethyl benzyl ammonium chloride (i.e., alcohol wipes).
1. Introduction

- DO NOT sterilize by heat, steam, ethylene oxide (ETO), or radiation. Apply disinfectants to the outside surface of the pump only. DO NOT use abrasive cleaners or materials on the pump. Using abrasive cleaners or cleaning solutions not recommended by Hospira may result in product damage.

- Please comply with local disposal and recycling regulations as appropriate for disposable batteries, rechargeable battery packs, medical electronic components, and pump sets.
Chapter 2

Basic Operation

The minimum elements required for using the GemStar® Pump are:

- GemStar® Pump
- Appropriate power source
- Appropriate GemStar® Pump Set
- Appropriate fluid container
- Patient-access device

Overview

To start a therapy:

1. **Determine the program settings.** Refer to the appropriate therapy chapter for a worksheet that may be copied and used to record program settings.

2. **Select a power source.** Refer to **Selecting a Power Source** on page 18.

3. **Prime the pump set.** Refer to **GemStar® Pump Set** on page 30.

4. **Load the cassette into the pump.** Refer to **Loading the Cassette** on page 33.

5. **Power-on the pump and go to the Delivery Mode Menu.** Refer to **Powering On the Pump** on page 25.

6. **Select the appropriate optional system components, such as a bolus cord.**

7. **Select the delivery mode and enter a program.** Refer to Chapter 3 Pain Management, page 45 for detailed instructions.

8. **Press [START] to begin delivery.**
2. Basic Operation

Selecting a Power Source

The GemStar® Pump may be powered by one or more of the following:

<table>
<thead>
<tr>
<th>Power Source</th>
<th>Description</th>
<th>Ambulatory</th>
<th>Hospital</th>
<th>Home</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar® AC Mains Adaptor (USA)</td>
<td>Wall-mount adaptor plugs into a 110 VAC mains supply.</td>
<td></td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>GemStar® AC Mains Adaptor (Universal)</td>
<td>Wall-mount adaptor plugs into a 100-240 VAC mains supply.</td>
<td></td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>GemStar® AC Mains Adaptor (Universal)</td>
<td>Tabletop adaptor plugs into a 100–240 VAC mains supply.</td>
<td></td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>GemStar® Docking Station</td>
<td>Plugs into a 100–240 VAC Volt mains supply while mounted on an I.V. pole. The docking station’s rechargeable internal batteries power the GemStar® Pump during periods of transport.</td>
<td></td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>GemStar® Battery Pack</td>
<td>The battery pack’s rechargeable internal batteries power the GemStar® Pump during periods of transport or when use of AC power is not desirable.</td>
<td></td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Disposable Batteries</td>
<td>Two disposable AA alkaline batteries (available from local sources)</td>
<td></td>
<td>•</td>
<td>•</td>
</tr>
</tbody>
</table>

CAUTION: To ensure proper pump operation, ALWAYS replace BOTH batteries with fresh, disposable AA batteries when a change is required.

DO NOT use rechargeable batteries in the battery compartment.

Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., AC Mains adaptor, docking station, battery pack). The pump will continue to operate on backup power if the external power source fails. Refer to the caution regarding Power Loss on page 13.
2. Basic Operation

**Installing Disposable Batteries**

1. **Flip open the tab of the battery door on the bottom of the pump.**
   
   *Note: Turn off the pump before removing or installing batteries.*

2. **With the pump keypad facing up, hold onto the tab and turn the battery door to the left (counterclockwise) until it is released from the battery compartment.**

3. **Pull the door free and remove any existing batteries.**

4. **Install two fresh, disposable AA batteries into the battery compartment. Ensure the batteries are inserted as shown.**

5. **Return the battery door to the battery compartment.**

6. **Turn the battery door to the right (clockwise). Ensure the battery door is secured under the slot.**

7. **Flip closed the tab of the battery door to lock in place.**
2. Basic Operation

Connecting the GemStar® AC Mains Adaptor

1. Connect the cord of the AC mains adaptor to the connector port labeled “3 VDC” on the bottom of the pump.

2. Plug the AC mains adaptor into a standard wall outlet.

CAUTION: ALWAYS connect to a grounded AC mains power source when using the AC mains adaptor. USE ONLY AC mains adaptors specifically labeled for use with the GemStar® Pump.

When removing the cord from the bottom of the pump, firmly grasp the connector and pull straight out. DO NOT twist or bend the cord or connector.

Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., AC Mains adaptor, docking station, battery pack). The pump will continue to operate on backup power if the external power source fails. Refer to the caution regarding Power Loss on page 13.

Note: The green LED on the pump remains lit when connected to AC mains power.
2. Basic Operation

**Using the GemStar® Rechargeable Battery Pack**

Use the GemStar® AC Mains Adaptor (List 13026-01 [USA], 13026-03 [Universal] or 13072-01 [Universal]) to recharge the GemStar® Battery Pack.

**WARNING:** DO NOT touch connector ports. Refer to caution on page 15.

**CAUTION:** ALWAYS connect to a grounded AC mains outlet when using AC mains adaptor.

- Use only AC mains adaptors specifically labeled for use with the GemStar® Pump to charge the battery pack.

- During charging, the battery pack is warm. If the battery pack becomes hot to the touch, IMMEDIATELY unplug AC mains power and contact Hospira Technical Support Operations.

- Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., AC Mains adaptor, docking station, battery pack). The pump will continue to operate on backup power if the external power source fails. Refer to the caution regarding Power Loss on page 13.

- When removing the cord from the bottom of the battery pack, firmly grasp the connector and pull straight out. DO NOT twist or bend the cord or connector.

Regarding the GemStar® Li-Ion Battery Pack:

The LED indicator on the GemStar® Li-Ion Battery Pack flashes green/yellow when an error condition has occurred or when the temperature is too high to charge the battery pack. In temperatures above 95°F (35°C), cycle AC power to confirm if battery is charged or if error condition exists. If LED flashes green/yellow, do not rely on external battery. Move device to cooler temperature and recharge prior to use.

Refer to the GemStar® Li-Ion Battery Pack insert for important information and precautions regarding activating and charging the Li-Ion Battery Pack.

*Note: A charged battery pack will last approximately 24 hours when the pump is infusing at rates less than 125 mL/hr.*
2. Basic Operation

**To connect the battery pack:**

1. Line up the connectors on the top of the battery pack with the holes on the bottom of the pump.
2. Snap the battery pack into place.

**To release the battery pack:**

1. Press the release button on the battery pack.
2. Pull the battery pack straight out from the pump.

*Note: When the pump is connected to the battery pack, the pump’s green LED flashes and the battery pack light is off.*

When the pump is connected to the battery pack at power-on, the pump displays **USING EXT BATT**.
2. Basic Operation

To charge the battery pack:

1. Plug the pin connector of the AC mains adaptor into the port on the bottom of the battery pack.
2. Plug the AC mains adaptor into a standard wall outlet.
3. Leave the battery pack connected to the AC mains adaptor for at least 12 hours to charge the battery pack.

Note: The Li-Ion battery pack (List 13073-03) light is yellow while the battery pack is charging and green when the battery pack is charged or not charging.

Li-Ion batteries cannot be charged when the room temperature is greater than 95°F (35°C) or less than 41°F (5°C)

CAUTION: When removing the cord from the battery pack, firmly grasp the connector and pull straight out. DO NOT twist or bend the cord or connector.
2. Basic Operation

Using the GemStar® Docking Station

WARNING: DO NOT touch connector ports. Refer to caution on page 15.

CAUTION: Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., AC Mains adaptor, docking station, battery pack). The pump will continue to operate on backup power if the external power source fails. Refer to the caution regarding Power Loss on page 13.

To Connect to the Pump

1. Mount the docking station to the I.V. pole and tighten the knob.
2. Line up the connectors on the bottom of the pump with the connectors on the docking station.
3. Slide the pump into the docking station until it snaps into place.
4. Connect the docking station to AC mains power.

To remove the pump:

1. Press the release button on the top of the docking station.
2. Slide the pump out.

To charge docking station (List 13075 all codes):

1. Connect the docking station to the AC mains power.
2. Leave the Li-Ion Docking Station connected to AC mains power for at least 6 hours when not in use or to recharge the docking station.

Note: The Li-Ion docking station (List 13075-03) light is yellow while the docking station is charging. When the docking station is charged or not charging, the light is green. The Li-Ion docking station cannot be charged when the room temperature is greater than 104°F (40°C) or less than 41°F (5°C).
2. Basic Operation

Powering On the Pump

**CAUTION:** If the pump does not display the self-test or if beeps do not sound at power-on, check all power connections and install two fresh, disposable AA batteries. If the problem continues, contact Hospira Technical Support Operations before using the pump.

*Note: If a cassette is not properly loaded, the pump will sound an alarm after the power-on test is complete.*

1. Press [ON/OFF] to power-on the pump. The pump completes a self-test and displays the time and date. No response is required.

   
   Note: The self-test takes approximately 30 seconds to complete. If the pump is locked, lock symbols appear at the beginning and end of the second line: ![UNIT SELF-TEST](image)

2. The pump checks for available power sources. Respond to the display message as shown in the following table:

<table>
<thead>
<tr>
<th>Display Message</th>
<th>Power Source(s)</th>
<th>User Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>No message displays</td>
<td>AC power and disposable batteries.</td>
<td>No response required, the pump goes to the next step.</td>
</tr>
<tr>
<td>LOW BATTERIES ENTER TO CONFIRM</td>
<td>AC power and weak (low voltage) disposable batteries; or weak disposable batteries only.</td>
<td>Press <img src="image" alt="UNIT" /> to confirm. Power-off the pump and install two fresh, disposable AA batteries as a backup power source.</td>
</tr>
<tr>
<td>NO INTERNAL BATT NO POWER LOSS ALARM AVAILABLE ENTER TO CONFIRM</td>
<td>No disposable batteries or dead disposable batteries; and external power.</td>
<td>Press <img src="image" alt="UNIT" /> to confirm. Power-off the pump and install two fresh, disposable AA batteries as a backup power source.</td>
</tr>
</tbody>
</table>
2. Basic Operation

<table>
<thead>
<tr>
<th>Display Message</th>
<th>Power Source(s)</th>
<th>User Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>USING BATTERIES ENTER TO CONFIRM</td>
<td>Disposable batteries only.</td>
<td>Press [YES] to confirm. If an external power source is in use, ensure the connections are secure.</td>
</tr>
<tr>
<td>USING EXT BATT ENTER TO CONFIRM</td>
<td>External batteries (docking station battery or battery pack) and disposable batteries.</td>
<td>Press [YES] to confirm. If an AC mains adaptor is in use, ensure the connections are secure.</td>
</tr>
</tbody>
</table>

Note: To power-off the pump, press and hold [ON/OFF] until the display clears. The pump cannot be powered off during a CHECK CASSETTE alarm (except during PROGRAMMING mode). Refer to Chapter 6 Troubleshooting for information on clearing a CHECK CASSETTE alarm.

CAUTION: Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., AC Mains adaptor, docking station, battery pack). The pump will continue to operate on backup power if the external power source fails. Refer to the caution regarding Power Loss on page 13.

For more information on: Refer to the following pages:

- Setting the clock: [Set Clock] in Chapter 4 Options Menu, on page 66.
- Locking the keypad: [Keypad Lock] in Chapter 4 Options Menu, on page 62.
2. Basic Operation

Accessing the Delivery Mode Menu

1. After power-on, the pump checks its memory for a stored program. Respond to the display message as shown in the following table:

<table>
<thead>
<tr>
<th>Display Message</th>
<th>Condition</th>
<th>User Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>The pump displays the Delivery Mode Menu.</td>
<td>Pump memory is clear.</td>
<td>▶ To enter a new program: Select a delivery mode from the Delivery Mode Menu and enter a new program. Refer to Chapter 3 Pain Management for instructions.</td>
</tr>
<tr>
<td>1 RESUME PROGRAM</td>
<td>A program is currently stored in pump memory.</td>
<td>▶ To continue the current program, press [1].</td>
</tr>
<tr>
<td>2 CLR PROG&amp;SHIFT</td>
<td></td>
<td>▶ To reset the current program:</td>
</tr>
<tr>
<td>3 CLR PROG,SHIFT AND HISTORY</td>
<td></td>
<td>▶ To enter a new program and clear shift totals: Press [2]. The pump clears the program and shift totals from memory and enters PROGRAMMING mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ To enter a new program, clear shift totals, and clear history: Press [3]. The pump clears the program, shift totals, and history from memory and enters PROGRAMMING mode.</td>
</tr>
</tbody>
</table>

Tip: To enter a new program when the pump is already powered on:

1. Press [STOP] to place the pump in STOP mode.
2. Press [CHANGE] to display the Change Menu.
3. Select NEW PROGRAM. The pump clears the current program and displays the Delivery Mode Menu.
2. Basic Operation

Programming the Pump

Programming Overview
The pump’s menu system provides step-by-step guidance through all of the programming steps. Refer to Chapter 3 Pain Management for detailed programming instructions.

A programming worksheet is available at the end of Chapter 3 that lists the minimum and maximum value (program range) allowed for a Pain Management therapy. If a number outside of the program range is entered, the pump displays the minimum or maximum value allowed.

1. Select the desired delivery mode from the Delivery Mode Menu.
2. Respond to display messages and enter requested values.

*Note: Program entries can be changed any time before the Program Review is complete. Press [BACK-UP] to return to previous program displays and make changes as desired.*


4. SAVING PROGRAM displays. The pump stores the program in memory and then enters STOP mode.

Tip: If you enter an incorrect number during programming, press [CHANGE] BEFORE pressing [YES/ENTER] to reset the number to zero. Then enter the correct number.
2. Basic Operation

**Programming Tips**

The following table explains how to use the keypad during programming:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0] - [9]</td>
<td>Press the number keys to select menu items and to enter numeric values.</td>
</tr>
<tr>
<td></td>
<td><strong>YES ENTER</strong> Press <strong>YES ENTER</strong> to accept entries or to continue when done viewing a display.</td>
</tr>
<tr>
<td></td>
<td><strong>HELP</strong> Press <strong>HELP</strong> during programming and alarm conditions to display information about the current condition.</td>
</tr>
<tr>
<td></td>
<td><strong>▼</strong> Press <strong>▼</strong> to toggle between units of measure when entering concentrations. Scrolls through program review and help messages.</td>
</tr>
<tr>
<td></td>
<td><strong>▲</strong> Press <strong>▲</strong> to insert a decimal point in a numeric value.</td>
</tr>
<tr>
<td></td>
<td><strong>CHANGE</strong> When entering a numeric value during programming, press <strong>CHANGE</strong> to reset the value to zero.</td>
</tr>
<tr>
<td></td>
<td><strong>BACK-UP</strong> Press <strong>BACK-UP</strong> to return to a previous display, to exit the Options Menu, or to exit the HELP mode.</td>
</tr>
</tbody>
</table>
2. Basic Operation

Starting a New Container

*Note: The NEW CONTAINER function is not available when the pump is in FULL Lock. Refer to Chapter 4 Options Menu, page 55 for more information on locking the keypad.*

**To repeat the current program with a new container:**

1. From the STOP mode, press [CHANGE] to display the Change Menu.
2. Select NEW CONTAINER from the Change Menu. The pump displays NEW CONTAINER for several seconds and clears the amount infused from memory.  
   *Note: In Pain Management therapy, the VTBI can be titrated without adding volume to initial container amount.*
3. Review the program. Press \(\downarrow\) to begin review.
4. Press [START] to begin delivery.

GemStar® Pump Set

The GemStar® Pump Set is a sterile, single-use, disposable pump set. It is designed for one-time use only and should be properly discarded after use.

Fluid path and areas beneath undisturbed protective set covers are sterile and nonpyrogenic in the intact unit package.

Contact a Hospira representative for more information on selecting the appropriate pump set configuration. Additional disposable components, such as air-eliminating filters and extension sets, may be added to the line as required. To use a GemStar® Pump Set, follow the instructions included with the set.

*Note: GemStar® Pump Sets contain a pressure-activated anti-siphon valve to reduce the potential for gravity flow at a typical 36-inch head height. Ensure slide clamp or lower CAIR® clamp is open prior to inserting cassette. The system may under deliver, and the system delivery accuracy may be reduced by as much as 5% when using the following:*

- nonvented syringes
- PCA vials (except in a lockbox with a spring assist mechanism)
2. Basic Operation

A typical GemStar® Pump Set is shown below:

1. Piercing Pin
2. Proximal End
3. Cassette
4. Flow Stop (open / close)
5. Distal End
6. Tubing
7. Slide Clamp
8. Secure Lock
9. Pressure-activated Anti-Siphon Valve
2. Basic Operation

**WARNING:** ALWAYS prime the pump set to remove air from the cassette, tubing, and injection sites prior to connecting to the patient. ALWAYS disconnect the pump set from the patient prior to priming or purging. Arrange tubing, cords, and cables to minimize the risk of patient strangulation or entanglement.

Failure to use the pressure-activated anti-siphon valve may result in unrestricted flow if the cassette is not properly installed in the pump.

**CAUTION:** USE ONLY GemStar® Pump Sets with the GemStar® Pump. Use of unauthorized sets may result in injury to the patient or damage to the pump.

To prevent contamination, use aseptic technique with all fluid-path connections. Remove protective coverings as assembly progresses.

**Opening the Pump Set**

1. Open the GemStar® Pump Set package and remove the contents.

2. Remove the protective covers from the fluid container administration port and the pump set.
2. Basic Operation

Loading the Cassette

1. Identify the four black cassette latches inside the cassette pocket.

2. Ensure slide clamp or lower CAIR® clamp is open prior to inserting cassette.

3. Line up the cassette as shown (with the flow stop button facing the pump).

4. Insert the cassette into the cassette pocket by pushing firmly along the entire cassette until it is firmly seated.
2. Basic Operation

5 Verify that all four cassette latches are securely holding the cassette.

![Cassette Latches](image)

Note: The pump cannot be powered off during a CHECK CASSETTE alarm (except during PROGRAMMING mode). Refer to Chapter 6 Troubleshooting for information on clearing a CHECK CASSETTE alarm.

6 Place the tubing in the tubing channel.

![Tubing Channel](image)

Note: Ensure the tubing is behind the tubing guide (at the distal end).

CAUTION: Ensure the cassette is properly installed. When properly installed, all four cassette latches are visibly holding the cassette securely in the cassette pocket.

Releasing the Cassette

1 Close the slide clamp on the distal line.

![Slide Clamp](image)

2 Push down on the cassette release (large black button) on the top of the pump.

![Cassette Release](image)

3 Remove the cassette.

![Cassette Release](image)

Note: When the cassette is released from the pump, the cassette flow stop automatically closes, preventing free flow.
2. Basic Operation

**Priming a GemStar® Pump Set**

*Priming Pump Sets WITHOUT a Drip Chamber*

**WARNING:** Failure to use the pressure-activated anti-siphon valve may result in unrestricted flow if the cassette is not properly installed in the pump.

1. Push down on the flow stop to close the cassette.

2. Hold the container with the administration port toward the ceiling and insert the piercing pin.

3. Push down on the flow stop to open (priming position) the cassette.

4. Invert the cassette approximately 45°.

5. While holding the rotated cassette, squeeze or roll the container to remove air from the container and cassette.

6. Return the cassette to the upright position. Continue priming until fluid fills the tubing.
2. Basic Operation

7 Push down on the flow stop (5) to close the cassette.

8 Ensure slide clamp is open prior to inserting cassette.

9 Load the cassette.

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 33.

Note: Ensure the tubing is behind the tubing guide (at the distal end).

CAUTION: When priming is complete, ensure no fluid flows at the distal end of the pump set. If flow is observed, DO NOT use the pump set.

10 Connect the pump set to the patient-access device.
   Priming using [PURGE] is only allowed before [START] is pressed or after one of the following events occur when using Pain Management therapy:
   • Complete Review of New Program
   • New Container
   • Air-in-Line Alarm
2. Basic Operation

*Priming Pump Sets WITHOUT a Drip Chamber Using the PURGE Key*

**WARNING:** Failure to use the pressure-activated anti-siphon valve may result in unrestricted flow if the cassette is not properly installed in the pump.

*Note: The PURGE function is available only if there is a program in the pump.*

1. Push down on the flow stop to close the cassette.
2. Hold the container with the administration port toward the ceiling and insert the piercing pin.
3. Ensure slide clamp is open prior to inserting cassette.
4. Load the cassette.

**CAUTION:** Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to *Loading the Cassette* on page 33.
2. Basic Operation

5 Program desired therapy.

6 Press [PURGE].

7 The pump displays PRIME THE SET? Press [YES/ENTER].

8 While holding the container with the administration port toward the ceiling, press and hold [PURGE].

Note: Purge rate is 250 mL/hr. The pump purges for up to 2 minutes each time you press and hold [PURGE].

Continue using the [PURGE] key until fluid fills the tubing. Ensure all air is removed from the container, cassette, and tubing.

CAUTION: When priming is complete, ensure no fluid flows at the distal end of the pump set. If flow is observed, DO NOT use the pump set.

9 Connect the pump set to the patient-access device.
2. Basic Operation

**Priming Pump Sets Using Pre-filled Vials**

**WARNING:** Failure to use the pressure-activated anti-siphon valve may result in unrestricted flow if the cassette is not properly installed in the pump.

A cracked vial might not show evidence of leakage until delivery pressure is applied.

When using the GemStar® Spring Assist Mechanism (SAM) Lockbox, USE ONLY GemStar® Pump sets designated for use with the GemStar® SAM Lockbox. Failure to use designated sets could result in unrestricted flow.

**CAUTION:** When using PCA vials (except in a lockbox with a spring assist mechanism), the system may underdeliver. System delivery accuracy could be reduced by as much as 5%.

When using pre-filled vials, ensure vial and injector are securely locked in lockbox before beginning delivery.

USE ONLY purge priming with the GemStar® Lockbox with Spring Assist Mechanism (SAM).

*Note: When using the GemStar® Lockbox with SAM, refer to the SAM pump set labeling and SAM lockbox insert for instructions.*

1. If using a pump set with the Y-extension, use the slide clamp to close off the KVO (Keep Vein Open) side of the tubing.

2. Open the upper and lower slide clamps.

![Diagram of slide clamp in action]
2. Basic Operation

3. Push down on the flow stop \( \Rightarrow \) to close the cassette.

4. Connect the pump set to a Hospira pre-filled vial and injector.

5. Push down on the flow stop \( \Rightarrow \) to open (priming position) the cassette.

6. Hold the vial and set upright (vertically) on a flat surface with the pump set extending from the top.

7. Slowly push down on the injector until fluid flows at the distal end of the tubing, which indicates that all air is cleared from the vial, injector, cassette, and tubing.

8. Push down on the flow stop \( \Rightarrow \) to close the cassette.

9. If the set includes a KVO Y-extension, close the slide clamp below the pre-filled vial and open the slide clamp on the KVO side. Prime the KVO Y-extension.

10. Ensure slide clamp is open on KVO side prior to inserting cassette.
2. Basic Operation

11 Load the cassette.

CAUTION: When priming is complete, ensure no fluid flows at the distal end of the pump set. If flow is observed, DO NOT use the pump set.

12 Connect the pump set to the patient-access device.

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 33.

Note: Ensure the tubing is behind the tubing guide (at the distal end).
2. Basic Operation

**Priming Pump Sets with Extensions**

**WARNING:** Failure to use the pressure-activated anti-siphon valve may result in unrestricted flow if the cassette is not properly installed in the pump.

1. Push down on the flow stop to close the cassette.

2. Hold the container with the administrative port toward the ceiling and insert the piercing pin.

3. Push down on the flow stop to open (priming position) the cassette.

4. Invert the cassette approximately 45°.

5. While holding the rotated cassette, squeeze or roll the container to remove air from the container and cassette.

6. Return the cassette to the upright position. Continue priming until fluid fills the tubing.
2. Basic Operation

7 Push down on the flow stop to close the cassette.

8 Connect the extension set to the pump set.

9 Ensure the slide clamp is open before inserting cassette.

10 Load the cassette.

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 33.

11 Program the desired therapy.

12 Press [PURGE].

13 The pump displays PRIME THE SET? Press [YES/ENTER].

14 Press and hold [PURGE].

Note: Purge rate is 250 mL/hr. The pump purges for up to 2 minutes each time you press and hold [PURGE].

Continue using the [PURGE] key until fluid fills the tubing. Ensure
all air is removed from the container, cassette, and tubing.

**CAUTION:** When priming is complete, ensure no fluid flows at the distal end of the pump set. If flow is observed, DO NOT use the pump set.

**15** Connect the pump set to the patient-access device.
Chapter 3

Pain Management

Therapy Features and Specifications

This therapy allows programming of a continuous only, bolus only, or continuous with bolus delivery.

- In Continuous + Bolus protocols, you can enter zero for either the continuous rate or the bolus dose when entering or changing a program. The continuous rate and bolus dose cannot be zero at the same time.
- The default bolus delivery rate is 125 mL/hr.

Note: The delivery rate is delivered in increments of .01.

- The maximum continuous delivery rate is 25 mL/hr.
- A loading dose may be set during programming, which can be delivered after programming and priming are complete. The default loading dose rate is 125 mL/hr. Rate, bolus dose, concentration can be programmed in increments of 0.01.
- Priming using [PURGE] is only allowed before [START] is pressed or after one of the following events occur:
  - Complete Review of New Program
  - New Container
  - Air-in-Line Alarm
  - VTBI can be titrated.

CAUTION: When using PCA vials (except in a lockbox with a spring assist mechanism), the system may underdeliver. System delivery accuracy could be reduced by as much as 5%.

Note: New Container is allowed only when at least 1/2 of the container volume has been infused or 1 hour has elapsed since starting the infusion.

The use of a lockbox is recommended with pain management protocols. Refer to Chapter 9 Optional System Components, page 109, for instructions on using a lockbox with the GemStar® Pump.
3. Pain Management

Tip: The Programming Worksheet at the end of this chapter lists the minimum and maximum values allowed for this therapy. Use copies of the programming worksheet to record program values before programming the pump.

**Pain Management Programming Tips**

The following table explains how to use the keypad during pain management programming:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0] - [9]</td>
<td>Selects menu items and enters numeric values.</td>
<td>DOWN</td>
<td>DOWN arrow toggles between units of measure when entering concentrations. Scrolls through program review and help messages.</td>
</tr>
<tr>
<td>YES/ENTER</td>
<td>Accepts entries or continues when done viewing a display.</td>
<td>The up</td>
<td>The up arrow inserts a decimal point in a numeric value.</td>
</tr>
<tr>
<td>HELP</td>
<td>Displays information during programming and alarm conditions.</td>
<td>BACK-UP</td>
<td>Returns to a previous display, exits the Options Menu, and exits the HELP mode.</td>
</tr>
<tr>
<td>CHANGE</td>
<td>Clears a numeric value (resets to zero) during programming.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
3. Pain Management

Pain Management Programming.

1. Select the delivery mode from the Delivery Mode menu.
   
   Note: If Continuous + Bolus is selected, the continuous delivery rate or bolus dose can be set to zero through the CHANGE menu without reprogramming the pump.
   
2. Select the unit of measure and concentration as required.
3. Set the continuous delivery rate.
4. Program a loading dose as required.
5. Program a bolus dose with lockout time and dose limit as required.

   Regarding a 1-Hour or 4-Hour Dose Limit: The hour dose limit is the maximum volume (continuous plus bolus or bolus only amount) that can be delivered over the selected period. When the programmed dose limit is reached, the continuous delivery stops and a new bolus is not allowed. As the oldest delivery amounts age out of the 1-hour or 4-hour dose limit record, the pump accepts bolus requests or resumes continuous delivery (if programmed).

   Note: If a 1-hour or 4-hour dose limit is programmed, a bolus in progress will stop when the amount infused reaches the dose limit.

   Loading doses are included in a 1-hour or 4-hour dose limit. A dose limit in effect could prevent the delivery of a loading dose.

6. If programmed in units of mcg or mg, the line displaying the units flashes. Enter the container size in proper unit measure.

   Note: To enter the total in mL when programming a concentration, press \( \text{\text{\textbackslash}} \) to move to the mL line. Enter the mL value when \( \text{\textbackslash mL} \) flashes on the display.

7. Select the air sensitivity, if required.
8. Review the program. Press \( \text{\text{\textbackslash}} \) to begin review.
9. If using the PURGE key to prime the pump set, press [PURGE] now.

WARNING: ALWAYS disconnect the pump set from the patient before priming or purging.
3. Pain Management

**Bolus Delivery**

Set bolus doses and delivery limits during programming. The default bolus dose delivery rate in a Pain Management therapy is 125 mL/hr.

A bolus cord is available for patient bolus requests. Refer to *Connecting the Bolus Cord* in Chapter 9 Optional System Components, on page 112, for more information.

**Delivering a Bolus Dose**

From the RUN mode, press either the bolus button [+ ] on the top of the pump or the button on the end of the bolus cord to begin bolus dose delivery. The pump flashes **BOLUS DELIVERY** on the display and the amount infused accrues as the delivery progresses.

When the bolus dose is complete, the pump does the following:

- Records the bolus request and delivery amount to the event and bolus history logs
- Adds the delivered boluses to the total bolus amount in the program amounts
- Resets the bolus lockout time (if applicable) and ignores other bolus requests until the lockout time has elapsed
- Continues programmed infusion

Note: **ALL bolus requests are recorded to the event and bolus history logs.**

If the bolus delivery does not start, it could be locked out by one of the following conditions:

- Bolus lockout period
- Loading dose delivery in progress
- Bolus dose delivery in progress
- Bolus per-hour limit
- 1-hour or 4-hour dose limit
3. Pain Management

**Bolus Dose Interruptions**

Bolus deliveries may be interrupted by:

- Pressing [STOP]
- An alarm condition

**To continue bolus delivery after an interruption:**

1. Press [START]. The pump displays **COMPLETE BOLUS NOW?**
2. Respond as follows:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Press this key:</th>
<th>Bolus lockout time is set to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deliver the remaining bolus amount</td>
<td>[YES/ENTER]</td>
<td>The time of delivery completion</td>
</tr>
<tr>
<td>Clear the undelivered bolus amount</td>
<td>[NO]</td>
<td>The time the bolus was interrupted</td>
</tr>
</tbody>
</table>

**Rate Titration**

**To titrate the rate while the pump is infusing:**

1. In the RUN mode, press the number keys for the new rate. Press [YES/ENTER].
   
   For example: if the current rate is 1.5 mL/hr, press [2][.] [5] [YES/ENTER] to change the rate to 2.5 mL/hr.
   
   Note: You have approximately five seconds after pressing a key to press another numeric key, the decimal key, or [YES/ENTER]. If no key is pressed within five seconds, the rate does not change and the delivery continues as previously programmed.

2. **NEW RATE** displays with the new value.
   - Press [YES/ENTER] within 10 seconds to accept the change and begin delivery at the new rate.
   - Press [NO] to continue delivery at the previously programmed rate.
3. Pain Management

Loading Dose Delivery

You can set a loading dose during programming, if desired. A loading dose can be delivered after programming and priming are complete.

Note: Loading dose amounts are included in a 1-hour or 4-hour dose limit.

Delivering a Loading Dose

1. After priming and programming, press [START].

When the loading dose is complete, the pump does the following:
- Automatically begins programmed infusion
- Records the dose amount to the history log
- Resets the bolus lockout time (if applicable) and ignores other bolus requests until the lockout time has elapsed

Loading Dose Interruptions

Loading dose deliveries can be interrupted by:
- Pressing [STOP]
- An alarm condition

To continue a loading dose:

1. Resolve the interruption.
2. Press [START]. The pump displays COMPLETE THE LOADING DOSE?
3. Pain Management

Respond as follows:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press this key:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deliver the remaining loading dose amount</td>
<td>YES ENTER</td>
</tr>
<tr>
<td>Clear the remaining loading dose amount</td>
<td>NO</td>
</tr>
</tbody>
</table>

Changing a Pain Management Program

<table>
<thead>
<tr>
<th>Can be changed at any time</th>
<th>Cannot be changed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery rate</td>
<td>Delivery mode</td>
</tr>
<tr>
<td>Bolus</td>
<td>Unit of measure</td>
</tr>
<tr>
<td>Bolus lockout</td>
<td>Concentration</td>
</tr>
<tr>
<td>Container size</td>
<td>Dose limit amount</td>
</tr>
<tr>
<td>Air sensitivity</td>
<td></td>
</tr>
<tr>
<td>Dose limit amount</td>
<td></td>
</tr>
</tbody>
</table>

Note: You cannot change a program when the pump is in FULL or CONTAINER Lock. With a RATE CHANGE Lock, the continuous delivery rate and bolus amount can be changed within the set ranges. Although the delivery mode cannot be changed, if Continuous + Bolus is programmed, the continuous rate or bolus amount can be changed to zero. The minimum values set with a RATE CHANGE Lock could restrict this function.

To change a program:

1. From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.
2. As each message displays, make the desired changes or press [YES/ENTER] to accept the current setting.
3. Review the program. Press ▼ to begin review.
4. Press [START] to begin delivery.
3. Pain Management

GemStar®

Pain Management Programming Worksheet

GIVE: _______________________________________

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Selections and/or Values to be Entered</th>
<th>Programmable Ranges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Therapy</td>
<td>Pain Management</td>
<td>N/A</td>
</tr>
<tr>
<td>Delivery Mode</td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>Delivery Mode</td>
<td>Continuous</td>
<td>N/A</td>
</tr>
<tr>
<td>Delivery Mode</td>
<td>Bolus Only</td>
<td>N/A</td>
</tr>
<tr>
<td>Delivery Mode</td>
<td>Continuous + Bolus</td>
<td>N/A</td>
</tr>
<tr>
<td>Unit of Measure*</td>
<td>Concentration: _______ mg/mL</td>
<td>0.01 - 100 mg/mL</td>
</tr>
<tr>
<td>Unit of Measure*</td>
<td>Concentration: _______ mcg/mL</td>
<td>1 - 1000 mcg/mL</td>
</tr>
<tr>
<td>Unit of Measure*</td>
<td>mL</td>
<td>0.01 - 100 mg/mL</td>
</tr>
<tr>
<td>Continuous Rate*</td>
<td></td>
<td>0.1 - 2500 mg/hr</td>
</tr>
<tr>
<td>Continuous Rate*</td>
<td></td>
<td>0.1 - 2500 mcg/hr</td>
</tr>
<tr>
<td>Continuous Rate*</td>
<td></td>
<td>0.1 - 25.0 mL/hr</td>
</tr>
<tr>
<td>Loading Dose</td>
<td>No</td>
<td>0.1 - 2500 mg</td>
</tr>
<tr>
<td>Loading Dose</td>
<td>Yes Amount: _______</td>
<td>0.1 - 2500 mcg</td>
</tr>
<tr>
<td>Loading Dose</td>
<td></td>
<td>0.1 - 25.0 mL</td>
</tr>
<tr>
<td>Bolus Dose*</td>
<td></td>
<td>0 - 2500 mg</td>
</tr>
<tr>
<td>Bolus Dose*</td>
<td></td>
<td>0 - 25000 mcg</td>
</tr>
<tr>
<td>Bolus Dose*</td>
<td></td>
<td>0 - 25.0 mL</td>
</tr>
<tr>
<td>Bolus Lockout</td>
<td></td>
<td>1 - 999 min</td>
</tr>
<tr>
<td>Optional Dose Limit</td>
<td>4-hour limit Amount: _______</td>
<td>4X rate - 400 mL, 40000 mg,</td>
</tr>
<tr>
<td>Optional Dose Limit</td>
<td>1-hour limit Amount: _______</td>
<td>400000 mcg*</td>
</tr>
<tr>
<td>Optional Dose Limit</td>
<td># boluses/hourNumber: _______</td>
<td>Rate - 100 mL, 10000 mg,</td>
</tr>
<tr>
<td>Optional Dose Limit</td>
<td>No dose limit</td>
<td>100000 mcg*</td>
</tr>
<tr>
<td>Optional Dose Limit</td>
<td></td>
<td>1 - 12</td>
</tr>
<tr>
<td>Optional Dose Limit</td>
<td></td>
<td>*For continuous plus bolus</td>
</tr>
<tr>
<td>Optional Dose Limit</td>
<td></td>
<td>delivery.</td>
</tr>
<tr>
<td>Optional Dose Limit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Container Size</td>
<td></td>
<td>0.1 - 999999 mg</td>
</tr>
<tr>
<td>Container Size</td>
<td></td>
<td>1 - 9999000 mcg</td>
</tr>
<tr>
<td>Container Size</td>
<td></td>
<td>0.1 - 9999 mL</td>
</tr>
</tbody>
</table>

Note: For Bolus Only, the 1-hour or 4-hour dose limit minimum is 1 bolus dose.
3. Pain Management

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Selections and/or Values to be Entered</th>
<th>Programmable Ranges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air Sensitivity**</td>
<td>☐ On Alarms at approx. 0.5 mL of air</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>☐ 2 mL Alarms at approx. 2 mL of air</td>
<td></td>
</tr>
<tr>
<td></td>
<td>☐ Off No alarm</td>
<td></td>
</tr>
</tbody>
</table>

* The delivery rate is programmable and is delivered in increments of .01.
** Air Sensitivity may not show in all setting configurations.

Note: *Titrating VTBI does not change initial container volume.*
Chapter 4

Options Menu

Overview

1. Press [OPTIONS] from RUN or STOP mode
2. Select the number key for the desired function.
3. Follow the display messages for the selected function. Refer to the appropriate description in this chapter for more information.

Note: Menu selections may vary depending on the configuration of the pump.

When the pump exits OPTIONS, the pump returns to the mode it was in when [OPTIONS] was pressed.

Tips for Using the Options Menu

The following keys are helpful when using the Options Menu:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0] - [7]</td>
<td>Selects menu items and enters numeric values.</td>
</tr>
<tr>
<td>YES ENTER</td>
<td>Accepts entries or continues when done viewing a display.</td>
</tr>
<tr>
<td>BACK-UP</td>
<td>Returns to a previous display, exits the Options Menu, and exits the HELP mode.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOWN arrow</td>
<td>DOWN arrow toggles between units of measure when entering concentrations. Scrolls through program review and help messages.</td>
</tr>
<tr>
<td>The up arrow</td>
<td>The up arrow inserts a decimal point in a numeric value.</td>
</tr>
</tbody>
</table>

Tip: A menu item does not have to be on the display to be selected. For example, only items 1 through 4 are shown when the Options Menu is first displayed. To select the Print Menu without scrolling the display, press [6].
### 4. Options Menu

<table>
<thead>
<tr>
<th>Select this item from the Options Menu:</th>
<th>To do this function:</th>
<th>Comments:</th>
</tr>
</thead>
<tbody>
<tr>
<td>REVIEW PROGRAM</td>
<td>Display the current program settings.</td>
<td>N/A</td>
</tr>
<tr>
<td>HISTORIES</td>
<td>Display the history for the latest 400 events, shift or volume totals, bolus history (if available), or current configuration settings. Clear the history. Display the Operation Test.</td>
<td>CAUTION: Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., AC Mains adaptor, docking station, battery pack). The pump will continue to operate on backup power if the external power source fails. Refer to the caution regarding Power Loss on page 13.</td>
</tr>
<tr>
<td>KEYPAD LOCK</td>
<td>Lock and unlock the keypad to prevent unauthorized changes to the program.</td>
<td>The lock levels allow the clinician to restrict access to various levels of pump operation.</td>
</tr>
<tr>
<td>PUMP SETTINGS</td>
<td>Change the air sensor, occlusion sensor, and sound level settings.</td>
<td>N/A</td>
</tr>
<tr>
<td>SET CLOCK</td>
<td>Set the clock.</td>
<td>The clock can be displayed in 12-hour or 24-hour format.</td>
</tr>
<tr>
<td>PRINT</td>
<td>Print the history event log, bolus history (if available), current program settings, and speed protocols.</td>
<td>Files may be downloaded to a printer or personal computer.</td>
</tr>
<tr>
<td>SPEED PROTOCOLS</td>
<td>Assign, review/recall, and delete the stored protocols.</td>
<td>Allows up to 9 speed protocols to be saved in pump memory.</td>
</tr>
</tbody>
</table>
4. Options Menu

**Review Program**

1. Press [OPTIONS] and select REVIEW PROGRAM. The pump displays PROGRAM REVIEW.
2. Press ⏪ to begin review.
3. Press [YES/ENTER] or [BACK-UP] when done to exit OPTIONS.

**Histories**

1. Press [OPTIONS] and select HISTORIES.
2. Select the number key for the desired function.
3. Complete the appropriate steps for the selected function.
4. Options Menu

<table>
<thead>
<tr>
<th>Select this item from the Histories Menu:</th>
<th>To do this function:</th>
<th>Display includes:</th>
</tr>
</thead>
<tbody>
<tr>
<td>HISTORY</td>
<td>Display history event log of the latest 400 events.</td>
<td>• Current date and time&lt;br&gt;• Date and time the program was cleared, a new container was selected, or a speed protocol was recalled&lt;br&gt;• History event log of the latest 400 events</td>
</tr>
<tr>
<td>SHIFT TOTALS</td>
<td>Display or clear shift totals.</td>
<td>• Time and date when shift was cleared&lt;br&gt;• Volume infused in the shift&lt;br&gt;• Any relevant program-specific information</td>
</tr>
<tr>
<td>VOLUME TOTALS</td>
<td>Display volume totals.</td>
<td>• Amount infused&lt;br&gt;• VTBI&lt;br&gt;• Any relevant program-specific information</td>
</tr>
<tr>
<td>CONFIGURATION</td>
<td>Display pump configuration.</td>
<td>• Dependent upon pump configuration</td>
</tr>
<tr>
<td>CLEAR HISTORY</td>
<td>Clear history event log and bolus history.</td>
<td>• CLEARING HISTORY displays for 3 to 4 seconds</td>
</tr>
<tr>
<td>BOLUS HISTORY</td>
<td>Display bolus history in hourly increments for the last 48 hours.</td>
<td>• Current date and time&lt;br&gt;• Number of boluses delivered&lt;br&gt;• Number of bolus demands&lt;br&gt;• Amount delivered through bolus delivery</td>
</tr>
<tr>
<td>OPERATION TEST</td>
<td>Perform user-assisted Operation Test.</td>
<td>• Messages that guide the user through each section of the test</td>
</tr>
</tbody>
</table>

Note: Some menu items may not be available depending on the configuration of the pump.

Tip: Press and HOLD ▲ or ▼ to scroll through the history displays faster.
4. Options Menu

**History**

To display the history event log:

1. Press [OPTIONS] and select HISTORIES.
2. Select HISTORY from the Histories Menu.
3. Press ▲ or ▼ to scroll the display.
4. Press [BACK-UP] when done to exit OPTIONS.

**Shift Totals**

To display the shift totals:

1. Press [OPTIONS] and select HISTORIES.
2. Select SHIFT TOTALS from the Histories Menu.
3. The shift totals display. Press ▲ or ▼ to scroll the display.

To clear the shift totals:

1. Follow the steps for displaying shift totals.
2. At the end of the shift totals, the pump displays CLEAR TOTALS? YES OR NO:
   - Press [YES/ENTER] to clear the shift totals.
   - Press [NO] to exit OPTIONS without clearing the shift totals.

Tip: Press [HELP] to display shift totals when the pump is not in PROGRAMMING mode or an alarm condition.
4. Options Menu

**Volume Totals**
To display the volume totals:
1. Press [OPTIONS] and select HISTORIES.
2. Select VOLUME TOTALS from the Histories Menu.
3. Press [BACK-UP] when done to exit OPTIONS.

To clear the volume totals:
1. Follow the steps for displaying volume totals.
2. At the end of the volume totals, the pump displays CLEAR TOTALS? YES OR NO:
   - Press [YES/ENTER] to clear the volume totals.
   - Press [NO] to exit OPTIONS without clearing the volume totals.

**Configuration**
To display the pump configuration:
1. Press [OPTIONS] and select HISTORIES.
2. Select CONFIGURATION from the Histories Menu.
3. Press [BACK-UP] when done to exit OPTIONS.

**Clear History**
To clear the history event log and bolus history:
1. Press [OPTIONS] and select HISTORIES.
2. Select CLEAR HISTORY from the Histories Menu.
3. The pump display CLEARING HISTORY for 3–4 seconds before exiting OPTIONS.

Tips:
- Press [BACK-UP] to exit OPTIONS immediately.
4. Options Menu

**Bolus History**

To display the bolus history:

1. Press [OPTIONS] and select HISTORIES.
2. Select BOLUS HISTORY from the Histories Menu.
3. Press [BACK-UP] when done to exit OPTIONS.

**Note:** Bolus History is only available if the current program has a bolus programmed, or had a bolus programmed at one time. The Bolus History is maintained in hourly increments for the latest 48 hours. The Bolus History is cleared when a new program is entered, a Speed Protocol is recalled, or the History is cleared.

**Operation Test**

The Operation Test checks several pump functions to ensure the GemStar® Pump is working properly. Refer to Chapter 8 Operation Test on page 99 for instructions.

---

Sample Bolus History

TIME IS 09:15 AM
Fri, Jun 11, 05
BOL DEL 30
BOL DEM 37
BOL AMT 30.0 mL
06:10A TO 09:14A
4. Options Menu

Keypad Lock

1  Press [OPTIONS] and select KEYPAD LOCK from the Options Menu.

2  Select the desired lock level.

The following lock levels, listed from lowest to highest restrictions, are available:

<table>
<thead>
<tr>
<th>Lock Level</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate Change</td>
<td>R</td>
</tr>
<tr>
<td>Lock</td>
<td></td>
</tr>
<tr>
<td>Container Lock</td>
<td>C</td>
</tr>
<tr>
<td>Full Lock</td>
<td>F</td>
</tr>
</tbody>
</table>

When the pump is locked under a particular level, a small lock symbol (🔒) appears next to the applied lock level as shown above. When the pump is in RUN or STOP mode, the lock symbol appears in the lower left corner of the display and the lock level abbreviation appears in the lower right corner.

Clinicians: refer to Chapter 5 Clinician Instructions on page 77 for detailed instructions.
4. Options Menu

### GemStar® Keypad Lock Level Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>U</th>
<th>R</th>
<th>C</th>
<th>F</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock/Unlock Keypad</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Pump On or Off</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start or Stop Infusion</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access Display, Help, Print, and Program Review Functions</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deliver a Bolus</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td>If programmed.</td>
</tr>
<tr>
<td>Silence an Alarm</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select a New Container</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purge</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change a Program</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td>Under Rate Change Lock, only the delivery rate or bolus dose volume can be changed and must be within the preset values.</td>
</tr>
<tr>
<td>Review/Recall Speed Protocol</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assign or Delete Speed Protocol</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Air Sensitivity, Distal Occlusion Level, Sound Level, and Clock</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear Shift Totals</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Program and Deliver a Loading Dose (Outside of Programming Mode)</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter a New Program</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operation Test</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear History</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
4. Options Menu

Change Pump Settings

1. Press [OPTIONS] and select PUMP SETTINGS.
2. Press the number key for the desired pump setting.
3. Follow the display messages. Refer to the instructions of the desired pump setting for more information.

<table>
<thead>
<tr>
<th>Select this item from the Pump Settings Menu:</th>
<th>To do this function:</th>
<th>Comments:</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIR SENSOR</td>
<td>Change the air sensor sensitivity.</td>
<td>The pump alarms when it detects an air bubble of approximately 0.5 mL when ON; or at approximately 2 mL when 2 mL is selected. The air alarm does not sound if OFF is selected. Note: The pump setting is inactivated if custom-configured (by your facility) to ON or 2mL. The air alarm can also be set during programming if the current therapy allows it.</td>
</tr>
<tr>
<td>OCCL SENSOR</td>
<td>Change the distal occlusion sensor sensitivity.</td>
<td>Default Setting: High The pump alarms when distal pressure is greater than the selected occlusion sensor limit.</td>
</tr>
<tr>
<td>SOUND LEVEL</td>
<td>Adjust the audible alarm level.</td>
<td>Default Setting: Maximum The alarm cannot be turned off completely. The alarm automatically reverts to the maximum volume if the user does not respond within one minute.</td>
</tr>
</tbody>
</table>

Note: The current setting flashes on the display.
4. Options Menu

Air Sensitivity

**WARNING:** To reduce the risk of infusing air, use an air-eliminating filter when the air sensitivity is set to OFF.

1. Press [OPTIONS] and select AIR SENSITIVITY. The current air sensitivity flashes on the display.

2. Select the desired Air Sensitivity level.

   *Note: If OFF is selected, the pump displays: Air ELIMINATING FILTER IS RECOMMENDED. ENTER TO CONFIRM You must press [YES/ENTER] to confirm.*

3. After selecting the desired Air Sensitivity, the pump displays: CHANGE AIR ALARM FROM XXXX TO XXXX:
   - Press [NO] to keep the current air sensitivity. The current air alarm status displays and the pump exits OPTIONS.
   - Press [YES/ENTER] to accept the new setting. The new air alarm status displays and the pump exits OPTIONS.

Occlusion Sensor

1. Press [OPTIONS] and select PUMP SETTINGS.

2. Select DISTAL OCCLUSION from the Pump Settings Menu.

3. Select the desired setting.

4. The pump displays MAKE XXXXX DEFAULT?
   - Press [NO] to temporarily change the distal occlusion setting. The new setting will be in effect until a new program is entered or the pump has been off for more than 24 hours.
   - Press [YES/ENTER] to permanently change the distal occlusion setting. The new setting will remain in effect until the setting is changed again through the Options Menu.
4. Options Menu

**Sound Level**

1. Press [OPTIONS] and select PUMP SETTINGS.
2. Select SOUND LEVEL from the Pump Settings Menu.
3. When the pump displays the Sound Level function, it sounds intermittent beeps at the current sound level. The blocks on the top line of the display indicate the current sound level.
   - Press ▲ to increase the sound level.
   - Press ▼ to decrease the sound level.
   - Press [CHANGE] to restore the sound level to the default setting.

*Note: The alarm cannot be turned off completely. The alarm automatically reverts to the maximum volume if the user does not respond within one minute.*


**Set Clock**

1. Press [OPTIONS] and select SET CLOCK.
2. Select 12-Hour or 24-Hour format (24-Hour format is shown in example).
3. Use the arrow keys to set the weekday and month.
4. Use the number keys to enter the current day, year, and time.

*Note: When entering the time in 12-Hour format, press ▲ or ▼ to toggle between AM and PM.*

5. Press [YES/ENTER] to confirm.

*Note: The clock cannot be changed while an intermittent or variable time program is in progress.*

Tip: To view the clock from the RUN or STOP mode, press [YES/ENTER], then immediately press and HOLD [1]. The clock displays until [1] is released.
4. Options Menu

Print

**WARNING:** Ensure a cassette is installed in the pump before connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a printer or computer.

**Note:** Ensure the printer is connected to the pump BEFORE selecting a print function. Refer to Connecting to the Seiko Printer on page 73 for more information.

1. Press [OPTIONS] and select PRINT.
2. Press the number key for the desired print function.
3. When printing is complete, the pump exits OPTIONS.

<table>
<thead>
<tr>
<th>Select this item from the Print Menu:</th>
<th>To do this function:</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRINT HISTORY</td>
<td>Print the current program, shift and volume totals, and history event log (400 events).</td>
</tr>
<tr>
<td>PRINT PROGRAM</td>
<td>Print the current program.</td>
</tr>
<tr>
<td>PRINT PROTOCOL</td>
<td>Print a specified speed protocol or a complete list of all speed protocols.</td>
</tr>
<tr>
<td>PRINT BOLUS Hx</td>
<td>Print the current program, shift and volume totals, and the bolus history (Hx) for the latest 48 hours.</td>
</tr>
<tr>
<td>STOP PRINT</td>
<td>Cancel printing. This function is only available if the pump is printing.</td>
</tr>
</tbody>
</table>
4. Options Menu

Speed Protocol

1. Press [OPTIONS] and select SPEED PROTOCOL.
2. Press the number key for the desired protocol function.
3. Follow the display messages. Refer to the instructions for Speed Protocol functions for more information.

*Note:* Up to nine speed protocols are stored at one time. The speed protocols stay in memory, even when the pump is powered down, until they are deleted.

<table>
<thead>
<tr>
<th>Select this item from the Speed Protocol Menu:</th>
<th>To do this function:</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASSIGN</td>
<td>Store a program in pump memory for later use.</td>
</tr>
<tr>
<td>REVIEW/RECALL</td>
<td>Review assigned protocols from the RUN or STOP mode. Recall an assigned protocol from the STOP mode.</td>
</tr>
<tr>
<td>DELETE</td>
<td>Delete protocols from pump memory.</td>
</tr>
</tbody>
</table>

Assign

1. Press [OPTIONS] and select SPEED PROTOCOL.
2. Select ASSIGN from the Speed Protocol menu.
3. Select [1]–[9] to assign to the new protocol.

If the selected speed protocol is already assigned, the pump displays REPLACE PROTOCOL ASSIGNMENT?

- Press [YES/ENTER] to replace the protocol. The pump displays the new speed protocol and exits OPTIONS.
- Press [NO] to keep the existing protocol and exit OPTIONS.
4. Options Menu

**Review/Recall**

1. Press [OPTIONS] and select SPEED PROTOCOL.
2. Select REVIEW/RECALL from the Speed Protocol menu.
3. Select the desired protocol to review/recall.
4. Review the program. Press ▼ to begin review.
5. Press [YES/ENTER]:
   - If in the RUN mode, the pump exits OPTIONS.

**Delete**

1. Press [OPTIONS] and select SPEED PROTOCOL.
2. Select DELETE from the Speed Protocol Menu.
3. Select the desired protocol to delete.
4. Press [YES/ENTER] to confirm deletion or [NO] to exit OPTIONS without deleting.
4. Options Menu

Connecting to the Data Port

Use the data port to connect the GemStar® Pump to a Seiko® DPU 414 or compatible serial printer to print the Operation Test results or the files available from the Print Menu. Using communication software included with most computer operating systems (or available from local sources), these files can also be transferred to a computer.

WARNING: Ensure a cassette is installed in the pump before connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a printer or computer.

Equipment Needed

<table>
<thead>
<tr>
<th>Equipment Needed</th>
<th>Connect to Printer</th>
<th>Connect to Computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar® Pump</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Hospira Serial Printer Cable List 13078-01</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Seiko DPU 414 or Compatible Serial Printer</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Serial DB9 Female-to-Female Gender Changer*</td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Null Modem*</td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Computer*</td>
<td></td>
<td>•</td>
</tr>
</tbody>
</table>

*Available from local sources.
4. Options Menu

**Configuration Settings**

Refer to the printer or computer documentation for information on configuration settings. Configure the printer or computer as follows to use the data port:

- **Baud Rate** = 2400
- **Data Bits** = 8
- **Stop Bits** = 1
- **Parity** = None
- **Carriage Return (+Line Feed)** = CR+LF
- **Flow Control** = None

*Note: When using the Seiko DPU 414 printer, the switch settings MUST be configured to work with the GemStar® Pump.*

To configure the switch settings on the Seiko DPU 414:

1. Press and hold the ONLINE button while sliding the POWER switch to ON.
2. When the list of the current settings start printing, release the ONLINE button.
3. Set the switches according to the following table.
   - Press the ONLINE button to continue setting switches.
   - Press ONLINE to set switch ON.
   - Press FEED to set switch OFF.
4. Continue setting switches until “Dip SW setting complete!!” is printed.
## 4. Options Menu

### Switch Settings for Seiko DPU-414 Printer

<table>
<thead>
<tr>
<th>Switch</th>
<th>Function</th>
<th>Setting</th>
<th>Button to Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW1-1</td>
<td>Input Method:</td>
<td>Serial</td>
<td>Off</td>
</tr>
<tr>
<td>SW1-2</td>
<td>Printing Speed:</td>
<td>High</td>
<td>On</td>
</tr>
<tr>
<td>SW1-3</td>
<td>Auto Loading:</td>
<td>On</td>
<td>On</td>
</tr>
<tr>
<td>SW1-4</td>
<td>CR function:</td>
<td>CR and LF</td>
<td>On</td>
</tr>
<tr>
<td>SW1-5</td>
<td>DIP SW setting command:</td>
<td>Enabled</td>
<td>On</td>
</tr>
<tr>
<td>SW1-6</td>
<td>Printing density:</td>
<td>100%</td>
<td>Off</td>
</tr>
<tr>
<td>SW1-7</td>
<td>Printing density:</td>
<td>100%</td>
<td>On</td>
</tr>
<tr>
<td>SW1-8</td>
<td>Printing density:</td>
<td>100%</td>
<td>On</td>
</tr>
<tr>
<td>SW2-1</td>
<td>Print Mode:</td>
<td>40 columns</td>
<td>On</td>
</tr>
<tr>
<td>SW2-2</td>
<td>User defined char:</td>
<td>On</td>
<td>On</td>
</tr>
<tr>
<td>SW2-3</td>
<td>Ordinary Characters:</td>
<td>On</td>
<td>On</td>
</tr>
<tr>
<td>SW2-4</td>
<td>Zero Font:</td>
<td>No slash</td>
<td>On</td>
</tr>
<tr>
<td>SW2-5</td>
<td>Character Set:</td>
<td>American</td>
<td>On</td>
</tr>
<tr>
<td>SW2-6</td>
<td>Character Set:</td>
<td>American</td>
<td>On</td>
</tr>
<tr>
<td>SW2-7</td>
<td>Character Set:</td>
<td>American</td>
<td>On</td>
</tr>
<tr>
<td>SW2-8</td>
<td>Character Set:</td>
<td>American</td>
<td>Off</td>
</tr>
<tr>
<td>SW3-1</td>
<td>Data bit length:</td>
<td>8 bits</td>
<td>On</td>
</tr>
<tr>
<td>SW3-2</td>
<td>Parity:</td>
<td>No parity</td>
<td>On</td>
</tr>
<tr>
<td>SW3-3</td>
<td>Parity condition:</td>
<td>Odd</td>
<td>On</td>
</tr>
<tr>
<td>SW3-4</td>
<td>Flow control:</td>
<td>H/S busy</td>
<td>On</td>
</tr>
<tr>
<td>SW3-5</td>
<td>Baud rate:</td>
<td>2400 bps</td>
<td>On</td>
</tr>
<tr>
<td>SW3-6</td>
<td>Baud rate:</td>
<td>2400 bps</td>
<td>Off</td>
</tr>
<tr>
<td>SW3-7</td>
<td>Baud rate:</td>
<td>2400 bps</td>
<td>Off</td>
</tr>
<tr>
<td>SW3-8</td>
<td>Baud rate:</td>
<td>2400 bps</td>
<td>On</td>
</tr>
</tbody>
</table>
4. Options Menu

Connecting to the Seiko Printer

WARNING: Ensure a cassette is installed in the pump before connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a printer or computer.

Refer to the printer documentation or contact the printer manufacturer for more information regarding Electrostatic Discharge (ESD) susceptibility of printer connector ports.

CAUTION: Do not connect the GemStar® AC Mains Adaptor to a printer.

Note: For maximum battery life, operate the pump on AC mains when connected to a printer or computer:

1. Install a cassette into the pump.
2. Connect the GemStar® serial cable to the printer and to the data port on the bottom of the pump.
3. Ensure the printer is ONLINE and ready to receive data. Refer to printer documentation for more information.
4. Ensure paper is loaded in the printer.
5. Select the desired print function from the pump menu.
4. Options Menu

**Connecting to a Computer**

**WARNING:** Ensure a cassette is installed in the pump before connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a computer or printer.

Refer to the computer documentation or contact the computer manufacturer for more information regarding Electrostatic Discharge (ESD) susceptibility of computer connector ports.

*Note: For maximum battery life, operate the pump on AC mains when connected to a printer or computer.*

1. Ensure slide clamp or lower CAIR® clamp is open prior to inserting cassette.
2. Install a cassette into the pump.
3. Connect the GemStar® serial cable to the null modem.
4. Connect the null modem to the serial gender changer.
5. Connect the serial gender changer to the serial port of the computer.
6. Connect the GemStar® serial cable to the data port on the bottom of the pump.
7. Configure the communication software on the computer. Refer to *Configuration Settings* on page 71.

*Tip: After the data transfer is complete, use any text editor to view or print the file.*
4. Options Menu

Transferring Data Using a Computer

The GemStar® can be connected to a Windows®-compatible computer. The following instructions apply to computers using Microsoft® Windows® 95, Windows® 98, or Windows NT® 4.0 or higher.

Creating a New Connection

Note: The following procedure is only needed to create a ‘New Connection’ the first time the pump is connected to the computer.

To create a new connection:

1. Follow steps 1–4 in Using an Existing Connection on the following page.
2. If a message appears asking if a modem is necessary for a connection, click NO.
3. Enter a name for the new connection (e.g., GemStar® Print Files) and choose an icon.
4. Click OK.
5. From the Connect drop-down menu, select the appropriate COM port.
6. Click OK.
7. Verify that the following settings are correct:
   - Baud Rate = 2400
   - Data Bits = 8
   - Stop Bits = 1
   - Parity = None
   - Flow Control = None
8. Click OK.
9. Select the Properties icon.
10. Select the Settings tab.
11. Select the ASCII setup button.
12. Ensure ‘Append line feeds to incoming line ends’ is checked.
13. Click OK in the ASCII setup window.
4. Options Menu

14 Click OK in the Properties window.
15 From the menu, select File > Save.
16 Exit HyperTerminal.

Using an Existing Connection

To transfer data from the GemStar® Pump to a computer:

1 From the Windows® desktop, select the Start Menu.
2 Select Programs.
3 Select Accessories.
4 Select HyperTerminal.
5 Double click on the icon with the name entered in step 3, To create a new connection, on page 70.
6 From the menu, select Call > Connect.
7 From the menu, select Transfer > Capture Text.
8 Type the path and file name where the printout should be saved.
   Ensure the file extension is “.txt”.
   The default path is: c:\windows\accessories\hyperterminal.
   
   Note: If the file name already exists, the new printout will be added to the end of the existing file. For example, use a patient’s name or id number as the file name. Then select that file for all of that patient’s printouts.
9 Click Start.
10 Select the desired print function from the pump. Refer to the table of printing functions on page 67.
11 Wait for the transmission to complete.
12 From the menu, select Transfer > Capture Text > Stop.
13 Exit HyperTerminal.
14 Use any text editor to view or print the file.
Chapter 5

Clinician Instructions

The instructions in this section apply to special features available to clinicians. Remove this section from the manual to prevent unauthorized access to these features.

The GemStar® Pump provides quick access to commonly used functions. Instead of accessing these functions by navigating through the menu system, you can enter the key combinations shown in this table:

<table>
<thead>
<tr>
<th>Function</th>
<th>Quick Access Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlock Keypad</td>
<td>Place the pump in STOP mode and then enter the lock sequence to unlock a Full Container or Rate Lock.</td>
</tr>
<tr>
<td>Displays Shift Totals</td>
<td>Place the pump in STOP mode and then press [HELP] to display Shift Totals.</td>
</tr>
<tr>
<td>Display Clock</td>
<td>Place the pump in STOP mode, press [YES], and then press and hold [1]. The clock displays until you release [1].</td>
</tr>
<tr>
<td>Program a Loading Dose</td>
<td>From the Pain Management STOP MODE, press [YES/ENTER], and then press [0] to program a Loading Dose.</td>
</tr>
</tbody>
</table>
5. Clinician Instructions

Clinician Locking Sequence Instructions

*Locking the Pump*

To lock the pump from the **RUN** or **STOP** mode:

1. Press **[OPTIONS]** to display the Options Menu.
2. Select **KEYPAD LOCK** from the Options Menu.
3. Select the desired lock level. For **CONTAINER** and **FULL** Lock, go to step 5.
4. For **RATE CHANGE** Lock, set the minimum and maximum programmable ranges for the continuous delivery rate and bolus dose in a Pain Management program.
   - **MIN** flashes on the display. Enter the minimum value.
   - **MAX** flashes on the display. Enter the maximum value.
5. Press **[YES/ENTER]** when done.
6. Repeat steps 4 and 5 for a bolus dose if available in the current program.
7. Enter the lock sequence number [1][3][0][0][0]. Asterisks display as the numbers are entered.

*Note: Default lock sequence numbers are shown.*

*Unlocking the Pump*

1. Press **[OPTIONS]** to display the Options Menu.
2. Select **KEYPAD LOCK** from the Options Menu.
3. Select the lock level to be unlocked.
4. Enter the lock sequence number for that level.
5. The pump displays the current lock level. Press **[YES/ENTER]** to return to the mode the pump was in when **[OPTIONS]** was pressed.
5. Clinician Instructions

Program and Deliver a Clinician Activated Loading Dose

This feature is available only when the keypad is UNLOCKED. The default loading dose rate is 125 mL/hr.

*Note: Loading dose amounts are included in a 1-hour or 4-hour dose limit.*

1. From the stop mode, press [YES/ENTER] [0].
3. Enter the loading dose. Press [YES/ENTER].
4. The pump displays: DELIVER THE LOADING DOSE NOW?
   To deliver the loading dose immediately, press [YES/ENTER].
   Primary infusion DOES NOT begin automatically when the clinician activated loading dose is complete. Press [START] to continue primary infusion.

   To deliver the loading dose later, press [NO].
   The pump returns to the stop mode. The next time [START] is pressed, the pump again displays: DELIVER LOADING DOSE NOW?
   • Press [YES/ENTER] to deliver the loading dose. Primary infusion continues automatically when the loading dose is complete.
   • Press [NO] to cancel the loading dose and continue primary infusion.

Shift Totals and History

**Shift Totals**

1. Press [OPTIONS] and select HISTORIES.
2. Select SHIFT TOTALS from the Histories Menu.
3. The shift totals display. Press \( \uparrow \) and \( \downarrow \) to scroll the display. When done, the pump displays CLEAR TOTALS? YES OR NO.
   • Press [YES/ENTER] to clear the shift totals.
5. Clinician Instructions

- Press [NO] to exit OPTIONS without clearing the shift totals.

Tip: Press [HELP] to display shift totals when the pump is not in PROGRAMMING mode or an alarm condition.

Clear History Event Log and Bolus History

1. Press [OPTIONS] and select HISTORIES.
2. Select CLEAR HISTORY.
3. CLEARING HISTORY displays and the pump exits OPTIONS.

Key Combinations Not on Screens

The table below lists special key combinations to access information or activate an activity which is not listed on the screen.

<table>
<thead>
<tr>
<th>Screen and/or Situation</th>
<th>Press</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>If a loading dose has been programmed but not delivered, displays the DELIVER LOADING DOSE NOW? screen</td>
<td>[YES/ENTER] + [0]</td>
<td>Displays the PROGRAM A LOADING DOSE? screen</td>
</tr>
<tr>
<td>CURRENT DATE AND TIME displaying</td>
<td>[YES/ENTER] + [1]</td>
<td>Displays the real time clock as long as 1 is held down</td>
</tr>
</tbody>
</table>
Chapter 6

Troubleshooting

This section contains information on audible and visual alarms that may occur with the GemStar® Pump.

CAUTION: If the pump does not perform as stated in this manual, stop using it IMMEDIATELY.

For consultation and technical support contact either an authorized Hospira representative or the Hospira Technical Support Operations hotline (available 24 hours a day).

To return the pump for service, first contact Hospira Customer Support between 7:00 AM and 4:00 PM Pacific time. Have the pump serial number available.

In the USA

Hospira Technical Support Operations
1-800-241-4002

Hospira, Inc.
Technical Support Operations
755 Jarvis Drive
Morgan Hill, CA 95037

Outside the USA: Contact your local Hospira sales office.

Tip: Press [HELP] for additional information during programming and alarm conditions.
6. Troubleshooting

## Alarm Messages

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIR IN LINE</td>
<td>Y</td>
<td>A = Audible alarm V = Visual alarm</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>A/V</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The specified volume of air has been detected in the line distal to the cassette while infusing.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 Press [SILENCE] to quiet the alarm for 1 minute.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 Press [STOP] to clear the alarm.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 Disconnect the patient from the pump set.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4 Press and hold [PURGE]. Note: Purge rate is 250 mL/hr. The pump purges for up to 2 minutes each time you press and hold [PURGE]. Purge volume may be limited in a Pain Management program.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5 Reconnect the pump set to the patient-access device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6 Press [START] to begin infusion.</td>
</tr>
</tbody>
</table>
6. Troubleshooting

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y = Yes</td>
<td></td>
<td>A = Audible alarm</td>
<td></td>
</tr>
<tr>
<td>N = No</td>
<td></td>
<td>V = Visual alarm</td>
<td></td>
</tr>
</tbody>
</table>

**CHANGE BATTERIES**

<table>
<thead>
<tr>
<th>N</th>
<th>A/V</th>
<th>The pump has entered the STOP mode due to battery voltage below acceptable levels.</th>
</tr>
</thead>
</table>

1. Replace both disposable batteries with fresh AA batteries and press \( \text{STOP} \) to restart the pump; or connect the pump to the AC mains adaptor and the pump will automatically restart. Replace both batteries as soon as possible.

**CAUTION:** Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., AC Mains adaptor, docking station, battery pack). The pump will continue to operate on backup power if the external power source fails. Refer to the caution regarding Power Loss on page 13.

2. After power-on, resume the current program. Refer to *Accessing the Delivery Mode Menu* in Chapter 2 Basic Operation for more information.
### 6. Troubleshooting

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CHECK CASSETTE-X</strong></td>
<td>N</td>
<td>A/V</td>
<td></td>
</tr>
</tbody>
</table>
|                       |                       | The cassette is improperly installed or not installed. | 1 Press [SILENCE] to quiet the alarm for 1 minute.  
|                       |                       | X indicates where to look for the cause of the alarm: | 2 Press [STOP] to place the pump in the STOP mode.  
|                       |                       | D = Distal            | 3 Ensure slide clamp or lower CAIR® clamp is open prior to inserting cassette.  
|                       |                       | P = Proximal          | 4 Reinstall the cassette.  
|                       |                       |                       | **CAUTION:** Ensure all four cassette latches are clearly visible after the cassette is installed.  
|                       |                       |                       | *Note: Ensure the tubing is behind the tubing guide (at the distal end). Refer to Loading the Cassette on page 33.*  
|                       |                       |                       | 5 Press [START] to begin infusion.  
|                       |                       |                       | *Note: The pump cannot be powered off during a CHECK CASSETTE alarm (except during PROGRAMMING mode).* |
| **CALL 1.800.XXX.XXXX** | N                     | A/V                   |        |
| CODE: NN/MMM/TTT (SERVICE ALARM) |                       | The pump has detected a condition that may require service. | 1 Write down the telephone number and code.  
|                       |                       |                       | 2 Power-off the pump. If the pump does not power-off, disconnect external power and remove the batteries.  
|                       |                       |                       | 3 Call the telephone number shown on the display message.  

---

**CALL 1.800.XXX.XXXX**

**CODE: NN/MMM/TTT (SERVICE ALARM)**
6. Troubleshooting

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>DIST. OCCLUSION</td>
<td>N</td>
<td>A/V</td>
<td></td>
</tr>
</tbody>
</table>

The pump has detected sustained distal pressure over the user-selected limit.

To avoid a bolus infusion after an occlusion, complete the following steps:

1. Press [STOP].
2. Close the distal clamp.
3. Press the cassette release button to remove the cassette from the pump.
4. Open the flow stop.
5. Wait 10 seconds.
6. Close the flow stop.
7. Load the cassette into the pump.
8. Open the distal clamp.
9. Review the program.
10. Press [START] to start the pump.

Press [SILENCE] to quiet the alarm for 1 minute.
Press [STOP] to place the pump in the stop mode.
Check for sources of distal occlusion:
- Kinked tubing below the pump
- Clamped patient-access device
- Clogged I.V. filter
- Other obstructions

If the problem continues, remove and reinstall the cassette.

**CAUTION:** Ensure all four cassette latches are clearly visible after the cassette is installed.

Note: Ensure the tubing is behind the tubing guide (at the distal end). Refer to Loading the Cassette on page 33.

Press [START] to begin infusion.
6. Troubleshooting

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOW BATTERIES</td>
<td>Y</td>
<td>A/V</td>
<td></td>
</tr>
</tbody>
</table>

The pump has detected battery voltage below acceptable levels and the batteries are the primary power source.

Note: The pump allows the user to clear the LOW BATTERIES alarm. If the condition has not been corrected after 15 minutes, the alarm continues.

If the pump is infusing and a LOW BATTERIES alarm occurs, the pump continues for approximately 30 minutes* before it can no longer deliver due to insufficient power.

*If an external power source is used, the rate is changed, or the pump is powered-on after a LOW BATTERIES alarm and those same batteries are still in the pump, this interval may be different.

1. Press [SILENCE] to quiet the alarm for 15 minutes.
2. Press [STOP] to place the pump in the STOP mode.
3. Connect the pump to AC mains adaptor, rechargeable battery pack, or press the On/Off key to turn off the pump and replace both disposable batteries with fresh AA batteries.

CAUTION: In the event that the internal batteries are removed while the pump is operating, the power loss event may not be logged in the history, the programmed therapy may not be retained, and the alarms (audible and visual) may not occur. Refer to the caution regarding Power Loss on page 13.

4. Power on the pump and resume the current program. Refer to Accessing the Program Menu in Section 2 for more information page 13.
5. Press [START] to begin infusion.

Note: In case of low battery alarm during printing, replace the batteries and reprint or Plug in AC main and reprint.
6. Troubleshooting

### POWER LOSS

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y = Yes</td>
<td>A = Audible alarm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N = No</td>
<td>V = Visual alarm</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| POWER LOSS            | N                     | A/V                   | 1. Connect the pump to AC mains adaptor, rechargeable battery pack, or replace both disposable batteries with fresh AA batteries.  
                          |                       |                      | 2. Power-on the pump and resume the current program. Refer to Accessing the Program Menu in Section 2 for more information. Review the program if required.  
                          |                       |                      | **CAUTION:** Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., AC Mains adaptor, docking station, battery pack). The pump will continue to operate on backup power if the external power source fails. Refer to the caution regarding Power Loss on page 13. |
6. Troubleshooting

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROX. OCCLUSION</td>
<td>N</td>
<td>A/V</td>
<td>1 Press [SILENCE] to quiet the alarm for 1 minute.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 Press [STOP] to place the pump in the stop mode. <strong>WARNING:</strong> When a Proximal Occlusion alarm activates, DO NOT power-off the pump.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 Check for sources of proximal occlusion:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>▶ Kinked tubing above pump</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>▶ Blockage in the container and in the spike</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>▶ Closed clamps above pump</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>▶ Empty container</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>▶ High torque syringe</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>▶ Other obstructions</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4 Remove obstructions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5 Press [START] to begin delivery.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6 If the problem continues, ensure slide clamp or lower CAIR® clamp is open. Power-off the pump. Reinstall the cassette. Turn on the pump. <strong>Note:</strong> Ensure the tubing is behind the tubing guides (at the distal end). <strong>CAUTION:</strong> Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 33.</td>
</tr>
</tbody>
</table>
### 6. Troubleshooting

#### Alarm Display Message

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y = Yes</td>
<td></td>
<td>A = Audible alarm</td>
<td></td>
</tr>
<tr>
<td>N = No</td>
<td></td>
<td>V = Visual alarm</td>
<td></td>
</tr>
</tbody>
</table>

#### USING BATTERIES

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>USING BATTERIES</td>
<td>Y</td>
<td>V</td>
<td></td>
</tr>
</tbody>
</table>

This is a normal response when:
- The pump has been powered on with only disposable batteries as a power source; or
- The pump has switched to internal power (disposable batteries) due to a loss of external power or a reduction in external power below acceptable levels.

When powering on the pump:
- Press [YES/ENTER] to confirm disposable batteries are the only power source.

When switching from AC Mains power:
- Press [SILENCE] to clear the alarm.

**CAUTION:** Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., AC Mains adaptor, docking station, battery pack). The pump will continue to operate on backup power if the external power source fails. Refer to the caution regarding Power Loss on page 13.
6. Troubleshooting

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y = Yes</td>
<td>A = Audible alarm</td>
<td>V = Visual alarm</td>
<td></td>
</tr>
<tr>
<td>N = No</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USING EXT BATT</td>
<td>Y</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This is a normal response when:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The pump has been powered on with external batteries as a power source; or</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The pump has switched to external battery power due to a loss of AC mains power; or</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The pump has switched to external battery power while running on internal batteries.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When powering on the pump:

- Press [YES/ENTER] to confirm external battery power source.

When switching from AC Mains power:

- Press [SILENCE] to clear the alarm.

CAUTION: Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., AC Mains adaptor, docking station, battery pack). The pump will continue to operate on backup power if the external power source fails. Refer to the caution regarding Power Loss on page 13.
6. Troubleshooting

Alert Messages

<table>
<thead>
<tr>
<th>Alert Display Message</th>
<th>Is the pump infusing?</th>
<th>Alar m Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y = Yes</td>
<td>A = Audible alarm V = Visual alarm</td>
<td>ALMOST EMPTY Y A/V Delivery will complete in 30 minutes or less. For bolus only program, delivery will complete during the next bolus delivery.</td>
<td>Press [STOP] to clear the alarm and put the pump in Stop Mode. Press [SILENCE] to clear the alarm. No additional alarms sound. Note: This alert is available only with Pain Management therapy.</td>
</tr>
<tr>
<td>N = No</td>
<td></td>
<td>CHECK PRINTER Y A/V The printer has not responded to commands from the pump. The printer is not properly connected to the pump.</td>
<td>1 Press [SILENCE] to quiet the alarm for 2 minutes. 2 Ensure the printer is properly connected to the pump by checking the following: Printer is powered on and in ONLINE mode. Cable is plugged in to both the pump and the printer. Cable part number and printer settings are correct. 3 If the problem continues, select STOP PRINT from the Print Menu to cancel all print jobs.</td>
</tr>
</tbody>
</table>
6. Troubleshooting

<table>
<thead>
<tr>
<th>Alert Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm</th>
<th>Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
</table>
| **EMPTY CONTAINER**   | N                     | A/V   | The pump has delivered the programmed container size or the pump has delivered the programmed VTBI; AND Auto KVO is delivering (if available in current program). | 1 Press [SILENCE] to quiet the alarm for 2 minutes.  
2 Press [STOP] to place the pump in the STOP mode and clear the alarm.  
3 Use the **NEW CONTAINER** function to repeat the current program. Refer to **Starting a New Container** in Chapter 2 Basic Operation.  
*Note: Titrations are allowed at this time.* |
| **FLASHING DISPLAY**  | N                     | A/V   | A Non-programming Callback has occurred because the pump has been waiting for more than three minutes for a keypress on a non-programming input or a confirmation display. | Follow the instructions on the display to clear the alarm. |
|                       |                       |       |                 |        |

**Y** = Yes  
**N** = No  
**A** = Audible alarm  
**V** = Visual alarm
### 6. Troubleshooting

#### Alert Display Message

<table>
<thead>
<tr>
<th>Is the pump infusing?</th>
<th>Alarm</th>
<th>Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
</table>
| **Y = Yes** | **A/V** | No disposable batteries or dead disposable batteries; AND external power. | 1. Press [YES/ENTER] to confirm.  
2. Power-off the pump and install two fresh, disposable AA batteries as a backup power source.  
**CAUTION:** Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., AC Mains adaptor, docking station, battery pack). The pump will continue to operate on backup power if the external power source fails. Refer to the caution regarding Power Loss on page 13. |
| **N = No** | | | |

**NO INTERNAL BATT**  
**NO POWER LOSS**  
**ALARM AVAILABLE**  
**ENTER TO CONFIRM**

| Programming Incomplete | **N** | **A/V** | Programming has not been completed and no keys have been pressed within three minutes. | 1. Press any key to clear the alarm.  
2. Complete the program entries. |
|------------------------|-------|-------|-------------------------------------------------|------------------------------------------------------------------|

**START**  
- **START** flashes on the display. Other parts of the display are not affected.

| **N** | **A/V** | A Stop Mode Callback has occurred because the programmed pump has remained in the STOP mode for more than three minutes. | 1. Press [SILENCE] to quiet the alarm for 3 minutes.  
2. Follow the instructions on the display to clear the alarm. |
|-------|-------|-----------------------------------------------------------------|------------------------------------------------------------------|
6. Troubleshooting

Other Display Messages

<table>
<thead>
<tr>
<th>Other Display Message</th>
<th>Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>KEYPAD LOCKED</td>
<td>User has attempted to perform a function that has been locked out.</td>
<td>Unlock the keypad to access the desired function.</td>
</tr>
<tr>
<td>NOT ALLOWED DURING INFUSION PRESS STOP TO HALT DELIVERY</td>
<td>User has attempted to perform a function that is not available in RUN mode.</td>
<td>• Press [STOP] to access the desired function.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Press [YES/ENTER] to return to the RUN mode display.</td>
</tr>
<tr>
<td>ROUNC IN PROGRESS NEW CONTAINER NOT ALLOWED</td>
<td>The pump has rounded a number that was entered during programming.</td>
<td>Press [YES/ENTER] to accept the rounded value and continue to the next step.</td>
</tr>
</tbody>
</table>
| CANNOT CHANGE CLOCK WHILE TIME BASED DELIVERY IS IN PROGRESS | User has attempted to change the clock during a time-based delivery.          | 1 Press [STOP].  
2 Increase the container size to complete the dose.  
3 Set NEW CONTAINER through the Change Menu. |
| THIS OPTION NOT AVAILABLE WHILE PROGRAMMING THE PUMP | User has attempted to access a function that is not available from the first programming display. | 1 Press [YES/ENTER] to return to the first programming display.  
2 Complete programming.  
3 Access desired function. |
Chapter 7

Maintenance

Pump Storage

Store the GemStar® Pump in a cool, dry place. **Remove the disposable batteries and the battery pack before storing the pump.**

Program and event history are protected in the software memory for at least one year when power is removed from the pump.

Cleaning and Disinfecting

Establish a routine schedule for cleaning the pump to keep the case exterior, cassette pocket, and tubing channel free of contamination.

**WARNING:** DO NOT touch connector ports. Refer to caution on page 15.

**CAUTION:** To avoid mechanical or electronic damage, do not immerse pump in any fluids or cleaning solutions.

Some cleaning and sanitizing compounds may slowly degrade components made from some plastic materials. Do not use compounds containing combinations of isopropyl alcohol and dimethyl benzyl ammonium chloride.

Do not sterilize by heat, steam, ETO, or radiation. Apply disinfectants to the outside surface of the pump only. Do not use abrasive cleaners or materials on the pump. Using abrasive cleaners or cleaning solutions not recommended by Hospira may result in product damage.

To avoid pump damage, cleaning solutions should be used only as directed in the table on the following page. The disinfecting properties of cleaning solutions vary; consult the manufacturer for specific information.

Never use sharp objects (such as pens, pencils, fingernails, paper clips, needles, etc.) to clean the pump.
7. Maintenance

**Recommended Cleaning Solutions**

The pump is not adversely affected by the recommended cleaning solutions in the table below:

<table>
<thead>
<tr>
<th>Cleaning Solution</th>
<th>Manufacturer</th>
<th>Preparation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vesphene II se®</td>
<td>Calgon Vestal Laboratories</td>
<td>Per manufacturer’s recommendation</td>
</tr>
<tr>
<td>Manu-Klenz®</td>
<td>Calgon Vestal Laboratories</td>
<td>Per manufacturer’s recommendation</td>
</tr>
<tr>
<td>Formula C™</td>
<td>Diversey Corp.</td>
<td>Per manufacturer’s recommendation</td>
</tr>
<tr>
<td>Household bleach (5.25% sodium hypochlorite)</td>
<td>Various</td>
<td>Per healthcare facility procedures; DO NOT exceed one part bleach in ten parts water</td>
</tr>
</tbody>
</table>

*Note: NOT all cleaning solutions are disinfectants. Check product labeling.*

**Cleaning the Pump Case**

1. Power-off the pump.
2. Disconnect the pump from AC mains power.
3. Clean the exposed surfaces of the pump with a soft, lint-free cloth dampened with the appropriate cleaning solution.
4. Wipe the solution from the pump surface with a water-moistened, lint-free cloth.
5. Use a dry, lint-free cloth to dry the pump after cleaning.
7. Maintenance

Cleaning the Cassette Pocket and Tubing Channel

The area containing the ultrasonic sensors, located in the cassette pocket, should be cleaned on a regular basis.

**CAUTION:** Use care not to damage the silicone seals around the sensor bodies.

1. Remove the cassette, if installed.
2. Use a cotton swab, moistened with an approved cleaning solution, to clean the sensor faces (A), tubing channel (B), plunger tip (C), and sensor pins (D).
3. Dry the sensor faces and tubing channel and ensure the sensor faces are free of detergent film and/or debris.

Repair

- The GemStar® Pump has no user-serviceable components, with the exception of disposable batteries.
- If the display clock stops working, contact Hospira Technical Support Operations to arrange for internal battery replacement.
- **Homecare Customers:** Call your healthcare professional or homecare company regarding any required service or repairs. DO NOT attempt to repair the pump for any reason.
- The GemStar® Pump is covered by a manufacturer’s warranty for one year after purchase. During this time, opening the pump case for any reason voids this warranty. Refer to Chapter 12 Warranty/Technical Assistance, page 145 for details.
- Refer all service to Hospira certified technicians only. A *GemStar® Technical Field Service Manual* is available to Hospira certified technicians.
Chapter 8

Operation Test

This test is designed to ensure the GemStar® Pump is operating properly. Hospira recommends performing this test a minimum of once every 12 months. Refer to facility requirements to determine additional testing needs.

The test can be performed when the pump is in the STOP mode and requires approximately 15 minutes to complete. The pump provides step-by-step instructions through each section of the test.

Note: This test is available only when the pump is UNLOCKED.

WARNING: Disconnect the pump from the patient BEFORE performing the Operation Test.

Equipment Required

- GemStar® Pump
- Two GemStar® Microbore Pump Sets without a filter
- Reservoir with at least 50 mL of water
- 20+ mL or larger graduated cylinder (graduated in 0.1 mL)
- Two fresh, disposable AA batteries
- Appropriate GemStar® AC Mains Adaptor or other Hospira approved external power source
8. Operation Test

Test Setup

Note: The pump clears any program and shift totals stored in pump memory before starting the Operation Test.

1. Connect the external power source and install two fresh, disposable AA batteries.
2. Power-on the pump.
3. Press [OPTIONS].
4. Select HISTORIES from the Options Menu.
5. Select OPERATION TEST from the Histories Menu.
6. Follow the instructions on the display.

Performing the Operation Test

Tip: The checklist at the end of this section may be copied to record test results.

Case Inspection

1. Visually inspect the case and keypad for damage. Check the case for missing screws, or labels.
2. Enter the results:
   - If the pump is free of damage and all the screws and labels are in place, press [YES/ENTER].
   - If damage is found on the case or keypad, or any screws or labels are missing, press [NO].
8. Operation Test

**Cassette Pocket and Latch Inspection**

1. Visually inspect the cassette pocket and the sensors (A). Verify that they are free of dirt and residue.
2. Verify that the four cassette latches (B) are present. Verify that they open and close when the cassette release button is pressed.
3. Verify that the plunger seal (C) and sensor seals (D) are present and intact.
4. Verify that the plunger (E) is not scraped or damaged.
5. Verify that the sensor pins (F) are not damaged.
6. Install the cassette. Verify that the cassette fits smoothly and securely.
7. Enter the results:
   - If the cassette pocket area and latches are free of damage, and ALL of the above steps are verified, press [YES/ENTER].
   - If damage is found, or ANY of the above steps cannot be verified, press [NO].
8. Operation Test

Power Check

Tip: Opening the battery compartment door will disconnect the batteries enough for the pump to recognize external power. Then the door can be tightened and testing can continue. This can save time when performing multiple tests on a group of pumps.

1. The display indicates that an external power source and batteries are connected. Press [ ].

2. Remove battery door and press [ ]. The display indicates that only external power is connected. Press [ ].

3. Return the battery door to the closed position.

4. Disconnect the external power source and press [ ].

5. The display indicates that only batteries are connected and displays the test results. Press [ ].

6. If the pump fails, reconnect the external power source and press [ ] to rerun the test, or press [YES/ENTER] to confirm failure.

Keypad Test


2. Enter the results:
   • If each key makes an audible tone, press [YES/ENTER].
   • If any key does not make an audible tone, press [NO].

Display Test

1. Press [YES/ENTER] when prompted. The display fills with solid boxes for approximately 10 seconds. To view the solid boxes for another 10 seconds after the display times-out, press [ ].

2. Enter the results:
   • If the display fills with solid boxes, press [YES/ENTER].
   • If the display does not fill with solid boxes, press [NO].
8. Operation Test

LED Test

1 Verify that both the Power (green) and Alarm (red) LEDs are lit. Refer to GemStar® Pump Layout on page 2 for the location of the LEDs.

2 Enter the results:
   • If both LEDs are lit, press [YES/ENTER].
   • If either of the LEDs does not light, press [NO].

Tip: Use two microbore pump sets to save time during the next four tests. The first set should be fully primed BEFORE beginning the volume accuracy test. Use a second, DRY set for the air-in-line test.

When the proximal occlusion test is complete, remove the WET set from the pump and insert the DRY set. Press [START] to begin the air-in-line test. The WET set can then be placed in the next unit ready for testing.

3 Ensure slide clamp is open prior to inserting cassette.

Volume Accuracy Test

The pump should deliver between 19.0 to 21.0 mL within approximately 3 minutes to pass this test.

1 Load a primed pump set into the pump. Press 

2 Place the proximal end in the reservoir of water. Press 

3 Place the distal end in a 20+ mL graduated cylinder. Press 

4 Press [START].

5 Enter the results:
   • If the pump delivers between 19.0 to 21.0 mL, press [YES/ENTER].
   • If the pump does not deliver between 19.0 to 21.0 mL, press [NO].
8. Operation Test

**Distal Occlusion Test**

The occlusion should occur within approximately 30 seconds to pass this test.

1. Clamp the pump set **10 to 12 inches** (25.4 to 30.5 cm) below the cassette.
2. Press [START].
3. The test result displays. Release the clamp and press ↓.
   - If the test is passed, the pump advances to the next test.
   - If the test is failed, clean the sensors and press [YES/ENTER] to rerun the test or press [YES/ENTER] to confirm failure.

*Note: Clean the sensor pins before repeating the distal occlusion test. Refer to Chapter 7 Maintenance for instructions.*

**Proximal Occlusion Test**

The occlusion should occur within approximately 30 seconds to pass this test.

1. Clamp the pump set above the cassette.
2. Press [START].
3. The test result displays. Press ↓.
   - If the test is passed, the pump advances to the next test.
   - If the test is failed, clean the sensors and press [YES/ENTER] to rerun the test or press [YES/ENTER] to confirm failure.

*Note: Clean the sensor pins before repeating the proximal occlusion test. Refer to Chapter 7 Maintenance for instructions.*
8. Operation Test

**Air-in-line Test**
The air-in-line alarm should occur within approximately 1 minute to pass this test.

1. Ensure slide clamp or lower CAIR® clamp is open prior to inserting cassette.
2. Release the clamp.
3. Remove the proximal end of the pump set from the reservoir. Press ▼.
4. Press [START].
5. The test result displays. Press ▼.
   - If the test is passed, the pump advances to the next test.
   - If the test is failed, clean the sensors and press △ to rerun the test or press [YES/ENTER] to confirm failure.

*Note: Clean the sensor faces before repeating the air-in-line-test. Refer to Chapter 7 Maintenance for instructions.*

**Printing Test Results**
When the test is complete, the pump displays an option to print the test results. If desired, follow the steps below to print the test results. An example of the printed test results is shown.

```
WARNING: Refer to the printer documentation or contact the printer manufacturer for more information regarding Electrostatic Discharge (ESD) susceptibility of printer connector ports.
```

*Note: For maximum battery life, operate the pump on AC mains power when connected to a printer or computer.*

1. Connect the serial printer cable to the pump. Refer to *Connecting to the Seiko Printer* in Chapter 4 Options Menu, on page 73.
2. Press [YES/ENTER] to print the test results.
3. The pump displays the Delivery Mode Menu when the results have finished transmitting or if [NO] is pressed.
8. Operation Test

* HOSPIRA GemStar *
* OPERATION TEST *
* RESULTS *
******************************************************************************

PUMP SERIAL NUMBER: XXXXXXXXX

10:45AM JUL 4, 05
VERSION X.X.X

1. Case Inspection       PASS
2. Cassette Pocket & Latch PASS
3. Power Check            PASS
4. Keypad Test            PASS
5. Display Test           FAIL
6. LED Test               PASS
7. Volume Accuracy Test   PASS
8. Distal Occlusion Test  PASS
9. Proximal Occlusion Test PASS
10. Air-in-Line Test      PASS

******************************************************************************

* VERIFIED BY: *
******************************************************************************

* END OF *
* OPERATION TEST *
* RESULTS *
******************************************************************************

12345678901234567890123456789012345678901234567890

Hospira GemStar Manual 430-10984-001 (Rev. 03/06)
8. Operation Test

GemStar®
Operation Test Checklist

<table>
<thead>
<tr>
<th></th>
<th>Pass</th>
<th>Fail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Inspection</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Cassette Pocket and Latch Inspection</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Power Check</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Keypad Check</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Display Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>LED Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Volume Accuracy Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Distal Occlusion Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Proximal Occlusion Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Air-in-line Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Printed Test Results</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>

Serial Number:

Verified By: ___________________________ Date: ____________
Chapter 9

Optional System Components

All GemStar® Optional System Components are composed of latex-free components only. All GemStar® Optional System Components are sold separately.

<table>
<thead>
<tr>
<th>Product Description</th>
<th>List #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar® AC Mains Adaptor (110 Volts - USA)</td>
<td>13026-01</td>
<td>Wall-mount adaptor plugs into a 110 VAC mains supply to power the GemStar® Pump. 6 ft (1.8 m) cord.</td>
</tr>
<tr>
<td>GemStar AC Mains Adaptor (100 – 240 Volts - Universal)</td>
<td>13026-03</td>
<td>Universal, wall-mount adaptor plugs into a 100 – 240 VAC mains supply to power the GemStar® Pump. 6 ft (1.8 m) cord.</td>
</tr>
<tr>
<td>GemStar® AC Mains Adaptor (100 – 240 Volts - Universal)</td>
<td>13072-01</td>
<td>Tabletop adaptor plugs into a 100 – 240 VAC mains supply to power the GemStar® Pump.</td>
</tr>
<tr>
<td>GemStar® Bolus Cord</td>
<td>13027-01</td>
<td>Allows bolus requests to be made up to 6 feet (1.8 m) from the pump.</td>
</tr>
<tr>
<td>GemStar® Pole Clamp</td>
<td>13076-01</td>
<td>Attaches the GemStar® Pump to an I.V. pole. The clamp is mounted to the track on the back of the pump. Press the release button to remove the pump.</td>
</tr>
<tr>
<td>GemStar® Locking Pole Clamp</td>
<td>20207-01</td>
<td>GemStar® locking pole clamp.</td>
</tr>
<tr>
<td>GemStar Battery Pack (Li-Ion)</td>
<td>13073-03</td>
<td>The rechargeable Li-Ion batteries power the GemStar® Pump during periods of transport or when use of AC power is not desirable. The battery pack is recharged using a GemStar® AC mains adaptor.</td>
</tr>
<tr>
<td>GemStar® Universal Lockbox</td>
<td>12499-01</td>
<td>Locks the GemStar® Pump and up to a 250 mL flexible I.V. container or 30 mL PCA vial in a plastic enclosure. The lockbox can be attached to an I.V. pole using the GemStar® Pole Clamp (available separately).</td>
</tr>
</tbody>
</table>
### 9. Optional System Components

<table>
<thead>
<tr>
<th>Product Description</th>
<th>List #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar Lockbox with Spring Assist Mechanism (SAM)</td>
<td>20706-01</td>
<td>Locks the GemStar® Pump and a 30 mL PCA vial in a plastic enclosure. The lockbox can be attached to an I.V. pole using the GemStar® Pole Clamp (available separately).</td>
</tr>
<tr>
<td>GemStar® 250 mL Lockbox</td>
<td>13024-01</td>
<td>Locks the GemStar® and up to a 250 mL flexible I.V. container in a plastic enclosure. The lockbox can be attached to an I.V. pole using the GemStar® Pole Clamp (available separately).</td>
</tr>
<tr>
<td>GemStar® 30 mL PCA Vial Lockbox</td>
<td>13077-01</td>
<td>Locks the GemStar® Pump and a 30 mL PCA vial in a plastic enclosure. The lockbox can be attached to an I.V. pole using the GemStar® Pole Clamp (available separately).</td>
</tr>
<tr>
<td>Hospira Carrying Case - 250 mL</td>
<td>13594-01</td>
<td>Soft-sided carrying case can be worn around the waist to hold the GemStar® Pump and up to a 250 mL flexible container.</td>
</tr>
<tr>
<td>Hospira Carrying Case - 500 mL</td>
<td>13079-01</td>
<td>Soft-sided carrying case can be worn around the waist or over the shoulder to hold the GemStar® Pump and up to a 500 mL flexible container.</td>
</tr>
<tr>
<td>Hospira Carrying Case - 1000 mL</td>
<td>13980-01</td>
<td>Soft-sided carrying case can be worn around the waist or over the shoulder to hold the GemStar® Pump and up to a 1000 mL flexible container.</td>
</tr>
<tr>
<td>Hospira Carrying Case - 3 Liter</td>
<td>13593-01</td>
<td>Soft-sided carrying case can be worn around the waist or as a backpack to hold a 3 liter or smaller flexible container and the GemStar® Pump with batteries or battery pack. Includes List 13590-01.</td>
</tr>
<tr>
<td>Hospira 3 Liter Carrier</td>
<td>13590-01</td>
<td>Interior support for the Hospira Carrying Case - 3 Liter.</td>
</tr>
</tbody>
</table>
## 9. Optional System Components

<table>
<thead>
<tr>
<th>Product Description</th>
<th>List #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar Docking Station (Li-Ion) (100 – 240 Volts)</td>
<td>13075-03</td>
<td>Plugs into a 100 – 240 VAC Volt mains supply to power the GemStar® Pump while mounted on an I.V. pole. During periods of transport, an internal rechargeable battery pack powers the pump for up to 16 hours at a rate of 125 mL/hr or less. When the AC mains supply is attached, the internal batteries are recharged in approximately 6 hours. 10 ft. (3 m) cord.</td>
</tr>
<tr>
<td>GemStar® Serial Cable</td>
<td>13078-01</td>
<td>Connects the GemStar® Pump to a compatible serial printer or computer to download the event history, program, or speed protocol information.</td>
</tr>
<tr>
<td>GemStar® Connect Clinician Kit</td>
<td>13048-01</td>
<td>Allows remote access from a clinician’s computer to a GemStar® Pump. The Kit includes a modem, phone cable, serial cable, and GemStar® Connect software.</td>
</tr>
<tr>
<td>GemStar® Connect Patient Kit</td>
<td>13049-01</td>
<td>Use with the GemStar® Connect Clinician Kit to allow remote access to a GemStar® Pump. The Patient Kit includes a modem, phone cable, and remote pump cable.</td>
</tr>
<tr>
<td>GemStar® Triple Pole Clamp</td>
<td>13022-01</td>
<td>Not for use with a lockbox. Holds up to three GemStar® devices.</td>
</tr>
<tr>
<td>GemStar® Configuration Guide</td>
<td>13000-97</td>
<td>Provides advance instructions for biomed technicians.</td>
</tr>
<tr>
<td>GemStar® System Operating Manual</td>
<td>13981-01</td>
<td>Provides operating instructions for patients and caregivers.</td>
</tr>
</tbody>
</table>
9. Optional System Components

Connecting the Bolus Cord
(List 13027-01)

Connect the bolus cord to the port labeled “Bolus” on the bottom of the pump.

WARNING: DO NOT touch connector ports. Refer to caution on page 15.

WARNING: When removing the cord from the bottom of the pump, firmly grasp the connector and pull straight out. DO NOT twist or bend the cord or connector.

Using the GemStar® Lockboxes

The GemStar® Lockbox is an enclosure that can be locked with a key to secure the pump, and a flexible container or vial. When the pump is secured in the lockbox, the user has access to the AC mains connector, data and bolus ports, keypad, and bolus button.

Note: For the GemStar® Universal Lockbox (List 12499-01) and GemStar® Lockbox with Spring Assist Mechanism (SAM) (List 20706-01) refer to the lockbox for instructions.
9. Optional System Components

**30 mL PCA Vial Lockbox (List 13077-01)**

1. Open the lockbox (A).
2. Flip the top door up (B).
3. Align the pump with the lockbox (C).
4. Slide the pump down into the lockbox until fully seated.
5. Flip the top door down.
6. Connect the pump set to the vial and prime.
7. Place the vial inside the lockbox (D).
8. Load the cassette (E).

**CAUTION:** Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to *Loading the Cassette* on page 33.

**Note:** Ensure the tubing is in the tubing guide (at the distal end).

9. Ensure the tubing will not be pinched when closing the lockbox.
10. Close and lock the lockbox.
11. Remove the key.
9. Optional System Components

250 mL Lockbox (List 13024-01)

1. Open the lockbox (A).
2. Flip the top door up (B).
3. Align the pump with the lockbox (C).
4. Slide the pump down into the lockbox until fully seated.
5. Flip the top door down.
6. Connect the pump set to the bag and prime.
7. Place the flexible container inside the lockbox with the administrative port down (D).
8. Hang the bag on the hook inside the lockbox (E).
9. Ensure slide clamp is open prior to inserting cassette.
10. Load the cassette (F).

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 33.

Note: Ensure the tubing is in the tubing guide (at the distal end).
9. Optional System Components

11 Ensure the tubing will not be pinched when closing the lockbox.
12 Close and lock the lockbox.
13 Remove the key.

Removing the Lockbox
1 Remove the lockbox from the pole.
2 Unlock the lockbox.
3 Open the lockbox and flip the top door up.
4 Press the cassette release button to remove the cassette.
5 Lift the pump out of the lockbox.

Using the Hospira Carrying Cases
Ensure the administration set is fully primed and the cassette is properly loaded before placing the pump in the carrying case. Refer to Chapter 2 Basic Operation for more information. Refer to Loading the Cassette on page 33 for more information.

Carrying Case - 250 mL (List 13594-01)
This soft-sided carrying case can be worn around the waist. It is designed to hold the GemStar® Pump and up to a 250 mL flexible fluid bag.

1 Place the fluid bag in the zippered compartment (A) on the backside of the case. Ensure the bag spike is positioned so that the fluid flow is not restricted.
9. Optional System Components

2 Place the pump inside the front compartment (B) of the case.

3 Secure the tubing to the inside of the pack with the Velcro® tabs (C). Ensure the tubing is not kinked.

4 Use the large Velcro flap (D) on the upper left side of the case to secure the tubing on the outside of the case.

5 Close the zipper. Ensure the tubing exits the side of the case near the zipper tab when the zipper is closed (E).

6 Place the case around the waist. Snap the buckle together to secure.

7 Adjust the belt for a snug, comfortable fit.

Carrying Case - 500 mL (List 13079-01) or 1000 mL (List 13980-01)

These soft-sided carrying cases can be worn around the waist or over the shoulder. They are designed to hold the GemStar® Pump and up to a 500 mL (List 13079-01) or a 1000 mL (List 13980-01) flexible fluid bag.
9. Optional System Components

1. Place the pump on the inside front window (A). Ensure the keypad is facing the "window."

2. Secure the pump with the large side straps (B) and (C). Then secure the top (D) and bottom (E) straps.

3. Place the fluid bag on the backside of the compartment (F).

4. Secure the bag with flaps (G) and (H).

5. Secure the bag spike with strap (I). Ensure the fluid flow is not restricted.

6. Use a "figure-8" pattern to wrap the tubing. Secure the tubing to the inside of the case with tabs (J) and (K). Ensure the tubing is not kinked.

7. Zip the case closed. Ensure the tubing exits through one of the sides near the zipper tab when the case is closed.
9. Optional System Components

Place the case around the waist with the front “window” facing away from the body. Snap the buckle together to secure. Adjust the belt for a snug, comfortable fit.

Carrying Case - 3 Liter (List 13593-01)

This soft-sided carrying case can be worn around the waist or as a backpack. It is designed to hold the GemStar® Pump with batteries or a battery pack, and up to a 3 liter flexible fluid bag.

Note: This carrying case includes an interior support (Hospira 3 Liter Carrier List 13590-01) that may be removed from the case and used separately.
9. Optional System Components

1. Unzip the carrying case and release all Velcro straps and flaps.
2. Place the fluid bag on the carrying case as shown (A).
3. Hook top strap (B) through the hole in the top of the fluid bag and secure.
4. Fold small flaps (C) and (D) over the bag as shown and secure.
5. Secure straps (E) and (F) across the length of the fluid bag and over the small flaps.
6. Secure the spike connection with strap (G).
7. Fold large flaps (H) and (I) over as shown and secure.
8. Place the pump, with the keypad facing upward, inside the pocket (J) on the flap. The pump’s display should be visible through the opening on the front of the pocket.
9. Secure the pump with straps (K) and (L).
10. Secure the tubing with strap (M).
11. Place the secured pump (N) inside the large zipper case or other carrying case.
12. Zip the large case closed.
13. If desired, route the tubing through the loops on the bottom of the carrying case. Ensure the tubing is not kinked.
14. Adjust the shoulder straps and waist belt for a snug, comfortable fit.

Tip: When not using the waist belt, secure it under the large flap on the back of the case.
9. Optional System Components
9. Optional System Components

Using the GemStar® Docking Station
(List 13075-01)

**WARNING: DO NOT touch connectors. Refer to caution on page 15.**

CAUTION: Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., AC Mains adaptor, docking station, battery pack). The pump will continue to operate on backup power if the external power source fails. Refer to caution regarding Power Loss on page 13.

**To Connect the Pump**

1. Mount the docking station to the I.V. pole and tighten the knob.
2. Align the connectors on the bottom of the pump with the connectors on the docking station.
3. Slide the pump into the docking station until it snaps into place.
4. Connect the docking station to AC mains power.

**To charge docking station:**

1. Connect the docking station to the AC mains power.
2. Leave the Li-Ion Docking Station connected to AC mains power for at least 6 hours when not in use or to recharge the docking station.

*Note: The Li-Ion docking station light is yellow while the docking station is charging. When the docking station is charged or not charging, the light is green. The Li-Ion docking station cannot be charged when the room temperature is greater than 104°F (40°C) or less than 41°F (5°C).*
9. Optional System Components

To connect the bolus cord and printer cable

WARNING: Ensure a cassette is installed in the pump before connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a printer or computer.

DO NOT touch connector ports. Refer to caution on page 15.

1. Plug the bolus cord into the bolus port on the rear, right side of the docking station.

2. Plug the printer cable into the printer port on the rear, right side of the docking station.

To remove the pump:

1. Press the release button on the top of the docking station.

2. Slide the pump out.
Chapter 10

Pump Sets

CAUTION: USE ONLY GemStar® Pump Sets with the GemStar® Pump. Use of unauthorized sets may result in injury to the patient or damage to the pump.

Contact a Hospira Representative for appropriate pump set configurations.

Fluid path and areas beneath undisturbed protective set covers are sterile and nonpyrogenic in the intact unit package.

The GemStar® Pump Sets listed in the table on the following page are available for use with the GemStar® Pump.

Note: The disposable pump sets should be changed per the Centers for Disease Control (CDC) guidelines or health care provider policy. Discard after use. All GemStar® Pump Sets are composed of latex-free components only.

GemStar® Pump Sets contain a pressure-activated anti-siphon valve to reduce the potential for gravity flow at a typical 36-inch head height.

Some microbore tubing delivery accuracy may be affected when used at extreme operating temperatures (<10°C, >35°C), relative humidity (<20%) and delivery rates (<4.9 mL/hr, >350 mL/hr). Refer to individual set labels for specific instructions and operating conditions.

The system may underdeliver, and the system delivery accuracy may be reduced by as much as 5% when using the following:

- nonvented syringes
- PCA vials (except in a lockbox with a spring assist mechanism)

Delivery accuracy may be impacted when there is air present in the cassette. Follow the instructions in the individual set labels to remove any visible air from the cassette.
10. Pump Sets

The following sets are a representation of the GemStar® Pump Sets currently available:

<table>
<thead>
<tr>
<th>List No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ambulatory Sets</strong></td>
<td></td>
</tr>
<tr>
<td>13263</td>
<td>Latex-Free GemStar® Pump Set and Extension Set with Integral Pressure-Activated Anti-Siphon Valve, Secure Lock, Nonvented, Microbore Tubing, 96 in (244 cm)</td>
</tr>
<tr>
<td>13264</td>
<td>Latex-Free, LifeShield®, GemStar® Pump Set with 0.2 Micron Filter, Secure Lock, Pre-pierced reseal injection site, Nonvented, Pre-Attached Pressure-Activated Anti-Siphon Valve, Microbore Tubing, 96 in (244 cm)</td>
</tr>
<tr>
<td>13265</td>
<td>Latex-Free, LifeShield®, GemStar® Pump Set with 1.2 Micron filter, Secure Lock, Pre-pierced reseal injection site, Nonvented, Pre-Attached Pressure-Activated Anti-Siphon Valve, NonPhthalate (Non-DEHP) Microbore Tubing, 96 in (244 cm)</td>
</tr>
<tr>
<td>13273</td>
<td>Latex-Free GemStar® Pump Set, Secure Lock, Nonvented, Pre-Attached Pressure-Activated Anti-Siphon Valve, Microbore Tubing, 96 in (244 cm)</td>
</tr>
<tr>
<td>13612</td>
<td>Latex-Free, Lifeshield® GemStar® Primary Set with orange polyethylene-lined light resistant tubing, 3 inch segment clear PVC tubing, Pre-Attached Pressure-Activated Anti-Siphon Valve, Secure Lock, Nonvented, Microbore tubing, 96 inch (244 cm).</td>
</tr>
<tr>
<td>20634</td>
<td>GemStar® Pump Set with orange polyethylene-Lined Light Resistant Tubing, 3 inch Segment of Clear PVC Tubing, 0.2 micron filter, CLAVE Port-SL, Attached Pressure-Activated Anti-Siphon Valve, Nonvented, 96 inch (244 cm)</td>
</tr>
<tr>
<td><strong>Pain Management Sets</strong></td>
<td></td>
</tr>
<tr>
<td>12640</td>
<td>Latex-Free, GemStar® Pump Set, Secure Lock, Nonvented Piercing Pin; And Extension Set with In-Line Pressure-Activated Anti-Siphon Valve, Y-Extension, Check Valve, Secure Lock, Microbore and Macroboare Tubing, 110 Inch (280 cm)</td>
</tr>
<tr>
<td>13045</td>
<td>Latex-Free, GemStar® Pump Set, Integral pressure-activated anti-siphon valve Secure Lock, Nonvented with PCA injector and female Luer Lock™ adapter, Microbore tubing, 96 in (244 cm)</td>
</tr>
<tr>
<td>13047</td>
<td>Latex-Free, GemStar® Pump Set with PCA Extension, Integral pressure-activated anti-siphon valve, Secure Lock, Nonvented with PCA injector and female Luer Lock™ adapter, Microbore tubing, 96 in (244 cm)</td>
</tr>
<tr>
<td>13261</td>
<td>Latex-Free, GemStar® Pump Set and Extension Set with integral pressure-activated anti-siphon valve, Secure Lock, Non-vented, Microbore tubing, 110 in (279 cm), Yellow Striped Tubing</td>
</tr>
</tbody>
</table>
## 10. Pump Sets

<table>
<thead>
<tr>
<th>Item Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20635</td>
<td>Latex-Free, GemStar® Pump Set, Yellow Striped Tubing, Secure Lock, Vented piercing Pin, 0.2 Micron filter, Microbore tubing, 110 in Friction fit anti-siphon valve (279 cm)</td>
</tr>
<tr>
<td>20704</td>
<td>Latex Free, GemStar® Pump Set with Injector, 2 Integral Pressure-Activated Anti-Siphon Valves, Secure Lock, Microbore Tubing, 99 inch (251 cm)</td>
</tr>
<tr>
<td>20705</td>
<td>Latex Free, GemStar® Pump Set with Injector, 2 Integral Pressure-Activated Anti-Siphon Valves and Y-Extension with Backcheck Valve, Secure Lock, Microbore Tubing, 97 inch (246 cm)</td>
</tr>
</tbody>
</table>
## Chapter 11

### GemStar® Pump Specifications

<table>
<thead>
<tr>
<th>Physical</th>
<th>The GemStar® Pump is composed of latex-free components only.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions:</td>
<td>Height: 5.7 in. (14.5 cm)</td>
</tr>
<tr>
<td></td>
<td>Width: 3.8 in. (9.7 cm)</td>
</tr>
<tr>
<td></td>
<td>Depth: 2.0 in. (5.1 cm)</td>
</tr>
<tr>
<td>Weight:</td>
<td>Approximately 18 oz. (526 grams) excluding batteries</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transport and Storage Environment</th>
<th>Store in cool and dry environment.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient Temperatures:</td>
<td>-4° F to +140° F (-20° C to +60° C)</td>
</tr>
<tr>
<td>Relative Humidity:</td>
<td>10% to 90%</td>
</tr>
<tr>
<td>Atmospheric Pressure:</td>
<td>0–10,000 ft. (0–3,000 m) equivalent pressure</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operating Environment</th>
<th>Ambient Temperatures:</th>
<th>+41° F to +104° F (+5° C to +40° C)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Power Sources</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AC Mains:</strong></td>
<td></td>
</tr>
<tr>
<td>List 13026-01 (USA) complies with UL544</td>
<td>Wall-mount AC mains adaptor; 6 ft. (1.8 m) cord molded plug</td>
</tr>
<tr>
<td>Input: 110 VAC</td>
<td>Output: 3.0 VDC</td>
</tr>
<tr>
<td>List 13026-03 (Universal) complies with CSA 22.2 N0 601.1 and UL 60601-1</td>
<td>Wall-mount AC mains adaptor; 6 ft. (1.8 m) cord molded plug</td>
</tr>
<tr>
<td>Input: 100-240 VAC</td>
<td>Output: 3.0 VDC</td>
</tr>
<tr>
<td>List 13072-01 (Universal) complies with CSA 22.2 N0 601.1 and UL 60601-1</td>
<td>Tabletop AC mains adaptor; molded plug</td>
</tr>
<tr>
<td>Input: 100–240 VAC</td>
<td>Output: 3.0 VDC</td>
</tr>
<tr>
<td><strong>Battery:</strong></td>
<td>Two disposable AA alkaline batteries</td>
</tr>
<tr>
<td><strong>Battery Pack:</strong> List 13073</td>
<td>Rechargeable using GemStar® AC Mains Adaptor</td>
</tr>
<tr>
<td></td>
<td>Lithium-ion rechargeable battery</td>
</tr>
</tbody>
</table>
11. GemStar® Pump Specifications

| Docking Station List 13075-03: | Mounts on an I.V. pole; 10 ft. (3 m) cord  
Input: 100–240 VAC  
Output: 3.0 VDC  
Internal lithium ion rechargeable battery |
|-----------------------------|-------------------------------------------------|
| Power Capacity              | Using two fresh, disposable AA batteries or a charged battery pack, at temperatures between 59° F and 95° F (15° C and 35° C), the pump is capable of delivering approximately:  
96 hours at rates below 5 mL/hr  
48 hours at rates at or above 5 mL/hr but below 25 mL/hr  
24 hours at rates at or above 25 mL/hr but below 125 mL/hr  
3000 mL at a rate of 125 mL/hr or higher |
| Pump Mechanism              | Volumetric, Piston Driven                        |
| Memory Protection           | Current program and 400-event (history) log protected by internal battery-backed memory for at least one year after power is removed |
| Operating Controls          | One 23-key keypad; bolus, data port, and AC mains jacks; bolus button |
| External Power LED          | Green LED marked with plug icon lights continuously when pump is connected to AC mains power  
Green LED flashes when pump is connected to external batteries |
| Alarm LED                   | Red LED marked with alarm icon lights during alarm conditions |
| Audible Alarm               | The audible alarm is user-adjustable from the maximum volume down to silent  
The alarm cannot be turned off completely. The alarm automatically reverts to the maximum volume if the user does not respond within one minute |
| Display                     | Backlit, four-line-by-sixteen-character alphanumeric graphics display  
Backlight on AC: Continuous  
Backlight on Batteries: Continuous during programming, program review, and history display; otherwise activated by keypress or alarm; not activated by bolus request |
| Real Time Clock             | Accuracy of ±5 minutes per month or better at temperatures between 59° F and 95° F (15° C and 35° C) |
11. GemStar® Pump Specifications

<table>
<thead>
<tr>
<th>Print Function</th>
<th>Port &amp; Interface: RS-232 serial interface port (data port), minimum baud rate of 2400, isolated circuit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Printers: Seiko DPU 414 or compatible serial printer</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>System Accuracy</th>
<th>Continuous</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>± 10% for rates of 0.1 mL to less than 5 mL/hr</td>
</tr>
<tr>
<td></td>
<td>± 5% for rates of 5 mL to 1000 mL/hr</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Air Sensitivity</th>
<th>ON: Pump alarms at approximately 0.5 mL of air</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Alarms for any bubble greater than 500 microliters with a tolerance of 200 microliters</td>
</tr>
<tr>
<td></td>
<td>2 mL: Pump alarms at approximately 2 mL of air</td>
</tr>
<tr>
<td></td>
<td>Alarms when pump detects 2.0 +1.0/-0.2 mL of air in 6 mL of total volume delivered</td>
</tr>
<tr>
<td></td>
<td>OFF: Alarm is not activated</td>
</tr>
<tr>
<td></td>
<td>Recommend using air-eliminating filter when Air Sensitivity is set to OFF</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Occlusion Sensitivity</th>
<th>Distal Occlusion: Alarms when pump detects distal pressure within a selectable range:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Low: 7 psi (48 kPa) ± 5 psi (±34 kPa)</td>
</tr>
<tr>
<td></td>
<td>Medium: 12 psi (83 kPa) ±8 psi (±55 kPa)</td>
</tr>
<tr>
<td></td>
<td>High: 26 psi (179 kPa) ±14 psi (±96 kPa)</td>
</tr>
<tr>
<td></td>
<td>Proximal Occlusion: Alarms when pump detects proximal pressure less than or equal to -4 psi (-28 kPa)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pump Self-Tests and Safety Features</th>
<th>Self-test performed when the power switch is activated</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Diagnostic routine, including motor speed and air-detection monitoring, is repeated continuously while the pump is powered on</td>
</tr>
<tr>
<td></td>
<td>Error and alarm conditions are indicated by both audible and visual alarms; delivery in progress is stopped, if appropriate (refer to Chapter 6 Troubleshooting)</td>
</tr>
</tbody>
</table>
11. GemStar® Pump Specifications

Occlusion Information

*Avoiding Bolus Infusion After Occlusion*

1. Press [STOP].

2. Close the distal slide clamp or lower CAIR® (roller) clamp.

3. Press the cassette release button to eject the cassette from the pump.

4. Press down on \( \mathcal{C} \) to open the flow stop.

5. Wait 10 seconds.

6. Press down on \( \mathcal{C} \) to close the flow stop.
11. GemStar® Pump Specifications

7 Ensure slide clamp or lower CAIR® clamp is open prior to inserting cassette.

8 Load the cassette.

**CAUTION:** Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to *Loading the Cassette* on page 33.

*Note:* Ensure the tubing is behind the tubing guide (at the distal end).
11. GemStar® Pump Specifications

9 Open the distal slide clamp.

10 Review the program. Press \( \text{START} \) to begin review.

11 Press [START] to start the pump.

**Stored Occlusion Volume**

<table>
<thead>
<tr>
<th>Delivery Rate of 25 mL/hr at</th>
<th>Pressure Limit</th>
<th>Stored Volume in mL</th>
<th>Time to Occlude in seconds</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pressure Setting:</td>
<td>Macro</td>
<td>Micro</td>
<td>Macro</td>
</tr>
<tr>
<td>Low</td>
<td>7 psig (48.3 kPa)</td>
<td>7 psig (48.3 kPa)</td>
<td>0.26</td>
</tr>
<tr>
<td>Medium</td>
<td>14 psig (96.5 kPa)</td>
<td>13 psig (89.6 kPa)</td>
<td>0.54</td>
</tr>
<tr>
<td>High</td>
<td>32 psig (220.6 kPa)</td>
<td>30 psig (206.8 kPa)</td>
<td>1.24</td>
</tr>
</tbody>
</table>

**Delivery Rate Accuracy**

The following trumpet curves represent the typical flow rate deviations, both positive and negative, from the programmed flow rate under test conditions defined by International Electrotechnical Commission (IEC) Standards for infusion pumps. Using these curves, the medical professional may determine if the device can be expected to perform in a manner suitable for the drug or fluid to be infused. The pump sets used in this test are comparable to GemStar® Pump Set List 13273.

The typical accuracy for this device is ± 5% of the programmed rate for most conditions, after a period of normalization. It is recommended that the medical professional refer to the following curves when making decisions regarding drug and fluid administration.

A single fault condition occurs when a single means for protection against a safety hazard in equipment is defective or a single external abnormal condition is present.

The maximum over-infusion volume from a single fault condition is based upon the calculation of the maximum time to generate an alarm times the maximum rate possible (1000 mL/hr) as a consequence of the fault. This has been determined not to exceed 2.78 mL.
11. GemStar® Pump Specifications

**CAUTION:** The system may underdeliver, and system delivery accuracy may be reduced by as much as 5% when using the following:

- nonvented syringes
- PCA vials (except in a lockbox with a spring assist mechanism)

Some microbore tubing delivery accuracy may be affected when used at extreme operating temperatures (<10°C, >35°C), relative humidity (<20%) and delivery rates (<4.9 mL/hr, >350 mL/hr). Refer to individual set labels for specific instructions and operating conditions.

**Trumpet Curves**

The Trumpet Curve Graphs following the Example show representative maximum and minimum percent flow rate deviation from the programmed rate over time. This information was developed in accordance with IEC 60601-2-24: 1998, Sub-Clause 50.102. Refer to this standard for detailed information.

How to read a Trumpet Curve Graph (Refer to example on the following page):

The graphs following the Example plot flow rates at 30 second intervals for the first 2 hours and for the 96th hour of delivery. The graph plots mean delivery rate error (Average of 3 pumps) for the 2nd hour and the 96th hour as a straight line. The graph also presents maximum and minimum average delivery rate error for this interval plotted by averaging delivery errors over intervals of 2, 5, 11, 19 and 31 minutes (“Trumpet Curve”).

**Example**

From the Trumpet Curve Graph sample that follows, find the 5 minute interval (A) at the horizontal axis and read the corresponding points (B) and (C) on the vertical axis. The values are approximately +2.8% and -0.5%.

This means that at the rate of 25 mL/hr the average maximum flow rate fluctuation for any 5 minute time interval during the 2nd hour of operation was within the limits of +2.8% and -0.5% from the nominal rate. The average delivery rate error over the entire 2nd hour was +1.6% (D).

For other time intervals look at other points at the horizontal axis and determine corresponding limits as above.
A trained professional can use the resulting graphs to select a pump with the appropriate startup and flow characteristics to suit the clinical application.

Note: As an example of how the trumpet curves can be used, consider the maximum and minimum deviations at the 5 minute average interval. The upper curve provides the maximum expected delivery rate error over a 5 minute interval, the lower curve provides the minimum expected delivery rate error over a 5 minute interval. An example would be Dopamine administered at 5 mcg/kg/min. At 5 minutes, the average drug delivery error would be within the range of +2.8% and -0.5% of the expected nominal rate.
11. GemStar® Pump Specifications

FLOW RATE
0.1 mL, 0 mm Hg Delivery Head, Start Up

PERCENT ERROR
0.1 mL, 0 mm Hg Delivery Head, Start Up

Observation Interval (minutes)
11. GemStar® Pump Specifications

FLOW RATE
0.1 mL, 0 mm Hg Delivery Head, Hour 96

PERCENT ERROR
0.1 mL, 0 mm Hg Delivery Head, Hour 96
11. GemStar® Pump Specifications

FLOW RATE
1 mL, 0mm Hg Delivery Head, Start Up

PERCENT ERROR
1 mL, 0 mm Hg Delivery Head, Start Up
11. GemStar® Pump Specifications

FLOW RATE
1 mL, 0 mm Hg Delivery Head, Hour 96

PERCENT ERROR
1 mL, 0 mm Hg Delivery Head, Hour 96
11. GemStar® Pump Specifications

FLOW RATE
25 mL, 0 mm Hg Delivery Head, Start Up

PERCENT ERROR
25 mL, 0 mm Hg Delivery Head, Start Up
11. GemStar® Pump Specifications

FLOW RATE
25 mL, 0mm Hg Delivery Head, 96 Hour

PERCENT ERROR
25 mL, 0 mm Hg Delivery Head, 96 Hour
11. GemStar® Pump Specifications

FLOW RATE
25 mL, -100 mm Hg Delivery Head, Start Up

PERCENT ERROR
25 mL, -100 mm Hg Delivery Head, Start Up
11. GemStar® Pump Specifications

FLOW RATE
25 mL, +100 mm Hg Delivery Head, Start Up

PERCENT ERROR
25 mL, +100 mm Hg Delivery Head, Start Up
11. GemStar® Pump Specifications

**FLOW RATE**
25 mL, 0 mm Hg Delivery Head, -20 in H2O Filling Head, Start Up

![Flow Rate Graph]

**PERCENT ERROR**
25 mL, 0 mm Hg Delivery Head, -20 in H2O Filling Head, Start Up

![Percent Error Graph]
Chapter 12

Warranty/Technical Assistance

The GemStar® Pump has been carefully manufactured using high-quality components. It is warranted to be free from defects in material and workmanship for a period of one year from the date of purchase under normal use and service. The warranty on the optional battery pack and other accessories is limited to 90 days.

On return to Hospira, the pump will be repaired or replaced within the terms of this warranty. Material returned to Hospira must be properly packaged and sent freight prepaid.

This warranty shall not apply if the pump has been repaired by anyone other than Hospira qualified service personnel; or altered in any way which, in Hospira's judgment, affects its stability or reliability; or if the serial number has been altered, effaced, or removed.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED.
12. Warranty/Technical Assistance

For customer service within the United States, contact:

1-877-9HOSPIRA (1-877-946-7747)

For technical assistance and product return authorization within the United States, contact:

1-800-241-4002

For additional technical assistance, including Technical Service Bulletins, technical training, and product information, visit the Web site at:

www.hospiraparts.com

After authorization, ship prepaid product returns to the following address:

Hospira, Inc.
Technical Support Operations
755 Jarvis Drive
Morgan Hill, CA 95037

Note: Outside the U.S, contact your local Hospira sales office.
Appendix A: Electrical Potentials

There is a shared responsibility between manufacturers, customers, and users to ensure that Medical Equipment and Systems are designed and operated as intended. Medical electrical equipment needs special precautions regarding electromagnetic compatibility and needs to be installed and used according to the electromagnetic compatibility information provided in this manual.

Guidance on EMC Compatibility

This device uses RF energy only for its internal functions. Its RF emissions are very low and are not likely to cause any interference in nearby electronic equipment.

The device is suitable for use in all establishments, including domestic establishments. If extended operation during power mains interruption is needed, use the battery pack or the docking station’s internal battery.

Always manage the electromagnetic environment. The guidance included in this manual provides information needed to:

- Determine the device’s suitability for use in the intended environment.
- Manage the electromagnetic environment to permit the device to perform as intended without disturbing other equipment.

Separate the device from all other electronic equipment. If the device must be used near other electrical equipment, monitor the equipment to ensure there is no electromagnetic interference.

Devices should not be used adjacent to or stacked with other equipment. If the device must be used adjacent to or stacked with other equipment, monitor the devices to verify normal operation.

USE ONLY components specifically labeled for use with the GemStar® Infusion System to help ensure the device operates as intended.

If you suspect external RF sources or other equipment are influencing device operation, contact the biomedical engineering department for additional guidelines concerning electromagnetic immunity.

Portable, mobile RF communications equipment (including cellular phones), and stationery RF devices (i.e., microwave ovens) can affect the operation of medical electrical equipment. Cellular phones should be turned off within 10 feet of all electronic medical devices. Other RF equipment should be used no closer to any part of the device, including all cables, than required. Monitor the devices to verify normal operation.
A. Electrical Potentials

Contact the biomedical engineering department for additional information in the technical service manual concerning operating devices near RF sources.

Information Regarding Electrostatic Discharge (ESD)

Electrostatic discharge is a transfer of electric charge between bodies of different electrostatic potential in proximity or through direct contact. For example, an electrostatic discharge might be observed when exiting a car on a very dry day. After exiting the car and then touching the car door, electrostatic discharge can often be felt and seen. Discharging one's body by touching the door with the car key will effectively eliminate these effects.

Electrostatic discharge can damage electronic equipment. At a minimum, all staff using the device, including clinical/biomedical engineering and healthcare staff, should read and adhere to the precautionary procedures below.

Precautionary Procedures

One of the most common causes of electrostatic damage to electronic devices is the direct transfer of electrostatic energy from the human body to the electrostatic, discharge sensitive electronic equipment.

- DO NOT touch any connectors with fingers or any hand-held metal object unless proper precautionary procedures have been followed.
- Methods to prevent build-up of electrostatic charge should be employed. The use of air conditioning and/or humidification, conductive floor coverings, and non-synthetic clothing is recommended during use or servicing of the device.
- It is recommended that the device be used in areas that have wood, concrete, or ceramic tile flooring. If floors are covered with synthetic material, the relative humidity should be at least 30%.
- To reduce the potential of damage from ESD:
  - Touch the frame of the device, earth, or a large metal object to discharge one's body.
  - Use a grounding wrist strap prior to touching connectors.
Index

Numerics
1-hour dose limit, 47
4-hour dose limit, 47

A
AC mains
  power connector, 4
  power indicator, 3
  Pump Specifications, 127
  regarding handling and maintenance, 12
  regarding pump operation, 12
  warnings and cautions, 12, 13
AC Mains Adaptor
  connecting to, 20
  warnings and cautions, 12, 13
administration set. See pump set
air sensitivity, 65
  regarding air-in-line infusion, 12
  specifications, 129
air-in-line alarm, 10, 12
  test of, 105
alarm messages, 82–90
alert messages, 91–93
anti-siphon valve, 12, 31, 32

B
BACK-UP key, 3, 29, 60
batteries, 73
  alarm messages, 83–90
  battery compartment, 4
  battery pack connector, 4
  installing disposable batteries, 19
  maintenance, 95
  power check, 102
  specifications, 127
  using the rechargeable battery pack, 21
  warnings and cautions, 12–13, 16
  baud rate, 129
  configuration settings for the data port, 71, 75
  switch settings for Seiko printer, 72
bolus, 9, 50
  bolus button, 4
  bolus delivery, 48–49
  bolus dose interruptions, 49
  connecting the bolus cord, 112, 122
history, 56
  locking the pump, 78
  occlusion information, 130
  optional system components, 109
in Pain Management therapy, 45–49
print history, 56, 67
  1-hour or 4-hour dose limit, 47

C
carrying cases
  using the Hospira carrying cases, 115–120
cassette, 31
  alarm message, 84
  cassette pocket, 4
  cassette release button, 4
  cleaning of, 95–97
  inspection of, 101
  loading the cassette, 33
  releasing the cassette, 34
  warnings and cautions, 12
Change History, ii
CHANGE key, 3, 29
Change Menu, 7
clinician instructions, 77–80
  locking the pump, 78
program and deliver a clinician activated loading dose, 79
unlocking the pump, 78
configuration settings, data port, 71
connecting the bolus cord, 112
connecting the GemStar® AC Mains Adaptor, 20
connecting to a computer, 74
See also data port
connecting to the Seiko printer, 73
See also data port
continuous delivery
in Pain Management therapy, 45–51
contraindications for use, 10

D
data port, connecting to, 70–74
configuration settings, 71
connecting to a computer, 74
connecting to the Seiko printer, 73
connector, 4
Delivery Mode Menu, 6
accessing the Delivery Mode Menu, 27
distal end, 31, 36, 103
distal occlusion, 5, 64
alarm message, 85
occlusion sensitivity, 129
occlusion sensor setting, 65
test of, 104
troubleshooting, 85
docking station, 111
charge, 24
connecting the bolus cord and printer cable, 122
connecting the pump, 121
to charge, 121
to remove the pump, 122
dose limit, 47

E
electrical potentials, 147
EMC compatibility, 147
ESD, 148
precautionary procedures, 148
event log, See history

F
flow stop, 31, 34, 35, 37, 40, 42, 130
Full Lock, 51, 62–63
lock level functions, 63
locking the pump, 78
unlocking the pump, 78

G
GemStar® Docking Station, 24
GemStar® pump components, 4
GemStar® pump features, 5
GemStar® pump layout, 2–3

H
HELP key, 3, 8, 29, 46, 59, 80, 81
HELP mode, 8
history, 5, 48, 50, 56, 95
display bolus history, 61
display, clear history, 60
print, bolus history, 56, 67

L
Li-Ion Battery Pack, 109
Li-Ion Docking Station, 111
loading dose, 47
clinician activated loading dose, 79
delivery, 49, 50–51
in Pain Management therapy, 45
loading the cassette, 33
lock, 3
Container Lock, 51, 62–63, 78
Full Lock, 51, 62–63, 78
keypad lock, 5, 56, 62
keypad lock level functions, 63
locking the pump, 78
Luer Lock, 11
Rate Change Lock, 51, 62–63, 78
lockboxes
using the GemStar® lockboxes, 112–115
locking the pump, 78
Luer Lock, 11

M
maintenance, 95–97
cleaning and disinfecting, 95
cleaning the cassette pocket and tubing channel, 97
cleaning the pump case, 96
recommended cleaning solutions, 96
repair, 97
Menu
Delivery Mode, Change, Options, 6

N
new container, 5
starting a new container, 30
troubleshooting, 92, 94

O
occlusion, 64
changing the occlusion sensor settings, 65
occlusion information, 130–132
occlusion sensitivity, 129
See also distal occlusion; proximal occlusion
occlusion sensor
changing the occlusion sensor settings, 65
See also occlusion; distal occlusion; proximal occlusion
Operating Modes
Help, Programming, Run, Stop, 8
operation test, 99–107
air-in-line test, 105
cassette pocket and latch inspection, 101
display test, 102
distal occlusion test, 104
equipment required, 99
keypad test, 102
LED test, 103
Operation Test Checklist, 107
power check, 102
printing the results, 105
proximal occlusion test, 104
test setup, 100
volume accuracy test, 103
optional system components, 109–122
OPTIONS key, 3
display shift totals, 59, 79
Options Menu, 7, 55–74
Histories, 57
Keypad Lock, 62
Operation Test, 61
Print, 67
Pump Settings, 64
Review Program, 57
Set Clock, 66
Speed Protocol, 68
other display messages, 94

P
Pain Management therapy, 45–53
1-Hour or 4-Hour Dose Limit, 47
bolus delivery, 48
changing a Pain Management therapy, 51
Delivery Mode menu, 27
features and specifications, 45
loading dose delivery, 49, 50
programmable ranges, 52
programming of, 47–48
Programming Worksheet, 52
power indicator, 3
power sources
  power check, 102
  selecting, 18
powering on the pump, 25
prime, 3, 32
priming, 11
  priming extension sets, 42
  priming pump sets using pre-filled vials, 39
  priming pump sets without a drip chamber, 35
  priming pump sets without a drip chamber using the PURGE Key, 37
See also prime; purge
Print, 67
printer
  connecting to pump, 73
  connecting to the data port, 70
  connecting to the docking station, 122
  serial cable, 111
programmable ranges
  in Pain Management therapy, 52
Programming Menu, 7
Programming Worksheet
  Pain Management, 52
proximal end, 31, 103
proximal occlusion
  alarm messages, 88
  occlusion sensitivity, 129
  test of, 104
pump components, 4
pump features, 5
  See also pump settings
pump layout, 2–3
pump set, 12–16, 123–124
pump settings, 3, 56
  air sensitivity, 65
  change pump settings, 64
  occlusion sensor, 65
  sound level, 66
pump specifications, 127–129
PURGE key, 3
  priming pump sets without a drip chamber using the PURGE Key, 37
R
  Rate Change Lock, 51, 78
  lock level functions, 63
  locking the pump, 78
rate titration
  in Weight Dosed therapy, 49
releasing the cassette, 34
remove the pump, 24
RUN mode, 8
S
  SILENCE key, 3
  Speed Protocols, 5, 56, 67
    assign, review/recall, delete, 68–69
  START key, 3
  STOP key, 3
  STOP mode, 8
T
  technical assistance, 146
  troubleshooting, 81–94
    alarm messages, 82–90
    alert messages, 91
    other display messages, 94
U
  unlocking the pump, 78
W
  warnings and cautions, 10
  Weight Dosed therapy
    rate titration, 49
Y
  YES/ENTER key, 3, 29
CAUTION: Federal (USA) law restricts this device to sale by or on the order of a physician or other licensed practitioner.

DANGER: Possible explosion hazard exists if used in the presence of flammable anesthetics.

Authorized Representative:
Hospira
Donegal Town
Co. Donegal, Ireland

The ‘C’ and ‘US’ indicators adjacent to the CSA Mark signify that the product has been evaluated to the applicable CSA and ANSI/UL Standards, for use in Canada and the U.S., respectively. This ‘US’ indicator includes products eligible to bear the ‘NRTL’ indicator. NRTL, i.e. National Recognized Testing Laboratory, is a designation granted by the U.S. Occupational Safety and Health Administration (OSHA) to laboratories which have been recognized to perform certification to U.S. Standards.

Equipment providing an adequate degree of protection against electrical and suitable for application to patient.

Protected against dripping water.

Attention: Consult accompanying documents.

The GemStar® Infuser has been assessed and complies with the following standard: IEC/EN 60601-1-2 (2001).

WARNING: DO NOT touch connector ports. Connector ports may be susceptible to Electrostatic Discharge (ESD) damage.

GemStar and LifeShield are registered trademarks of Hospira, Inc. Luer Lock is trademark of Hospira, Inc. Super Edisonite, Seiko, Vesphene II se, Manu-Klenz, Formula C, Teflon, Velcro, CLAVE, and Microsoft, Windows, and Windows NT are not trademarks of Hospira.

This document and the subject matter disclosed herein are proprietary information. Hospira retains all the exclusive rights of dissemination, reproduction, manufacture and sale. Any party using this documentation accepts it in confidence, and agrees not to duplicate it, in whole or in part, nor disclose it to others without the written consent of Hospira.

© 2006 Hospira, Inc.
Lake Forest, Illinois 60045, USA
Printed in USA